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1. Abstract 

 

In recent years the Internet offers businesses a new range of communication 

possibilities , penetration and growth. The increased competition in recent years has 

led firms to adopt new technologies and applications, through the framework of 

Ecommerce . This thesis is an approach to e-commerce and inter-organizational  

systems by using web services . 

The object of this thesis is the study of content management systems (CMS) 

.Reference was made to definitions , mode , characteristics and advantages . Also 

there is a study of cloud services that are used in on-Line platforms to create and 

edit documents and many other occasions. One of the companies that provides such 

a service platform is google. In this work we used the services of Google Drive, 

Google Analytics and Google Maps. 

The ultimate goal is to create an online store biological products using the open 

content management system Joomla. Purpose is the online store , bring an attractive 

use of available products to prospective customers , be friendly to all users and to 

project a credible profile . 

For the construction of the shop used various technologies and components , 

including component and HikaShop, for which full reference is made to the settings, 

capabilities and general features  
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1. Σύνοψη 
 

Τα τελευταία χρόνια το διαδίκτυο προσφέρει στις επιχειρήσεις ένα νέο φάσμα 

δυνατοτήτων επικοινωνίας , διείσδυσης και ανάπτυξης.  Ο αυξημένος ανταγωνισμός 

των τελευταίων χρόνων έχει οδηγήσει τις επιχειρήσεις στην υιοθέτηση σύγχρονων 

τεχνολογιών και εφαρμογών, μέσω του πλαισίου του Ηλεκτρονικού εμπορίου.  Η 

συγκεκριμένη πτυχιακή εργασία αποτελεί μια προσέγγιση του θέματος του 

Ηλεκτρονικού εμπορίου και των Διεπιχειρησιακών πληροφοριακών συστημάτων 

με χρήση των υπηρεσιών διαδικτύου. 

Το αντικείμενο της παρούσας πτυχιακής εργασίας είναι η μελέτη των συστημάτων 

διαχείρισης περιεχομένου (CMS) . Έγινε αναφορά σε ορισμούς, στον τρόπο 

λειτουργίας, στα χαρακτηριστικά και τα πλεονεκτήματα τους. Επίσης γίνεται μελέτη 

των  cloud services οι οποίες χρησιμοποιούνται σε on-Line πλατφόρμες για την 

δημιουργία και επεξεργασίας εγγράφων και σε άλλες πολλές περιπτώσεις. Μία από 

τις εταιρίες που μας παρέχει μία τέτοια πλατφόρμα υπηρεσιών είναι η google. Στην 

παρούσα εργασία χρησιμοποιήθηκαν οι υπηρεσίες Google Drive, Google Analytics 

και Google Maps. 

Τελικός στόχος είναι η δημιουργία ενός ηλεκτρονικού καταστήματος βιολογικών 

προϊόντων χρησιμοποιώντας το ανοιχτού περιεχομένου σύστημα διαχείρισης 

Joomla. Σκοπός είναι το ηλεκτρονικό κατάστημα να προβάλλει με ελκυστικό τρόπο 

τα διαθέσιμα προϊόντα στους υποψήφιους πελάτες, να είναι εύχρηστο προς όλους 

τους χρήστες και να προβάλει ένα αξιόπιστο προφίλ.  

Για την κατασκευή του ηλεκτρονικού καταστήματος χρησιμοποιήθηκαν διάφορες 

τεχνολογίες και συστατικά, μεταξύ αυτών και το συστατικό HikaShop, για το οποίο 

γίνεται πλήρη αναφορά των ρυθμίσεων, των δυνατοτήτων και των γενικών 

χαρακτηριστικών του.  
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2. Ηλεκτρονικό Εμπόριο 

2.1. Βασικοί όροι  

     

Κάθε μορφή εμπορικής συναλλαγής μεταξύ προσώπων που γίνεται με ηλεκτρονικά 

μέσα ονομάζεται ηλεκτρονικό εμπόριο. Αφορά όλες τις λειτουργίες που έχει ένα 

κατάστημα όπως για παράδειγμα αγοραπωλησίες, εκπτώσεις, προσφορές κτλ. Το 

ηλεκτρονικό εμπόριο μπορεί να έχει μορφή λιανικής με την επιχείρηση και τους 

καταναλωτές αλλά και χονδρικής μεταξύ των επιχειρήσεων. Με τη χρήση ενός 

υπολογιστή γίνεται πολύ εύκολα η αγορά ή η πώληση προϊόντων γρήγορα, 

οικονομικά και αξιόπιστα. Τα τελευταία χρόνια έχει αυξηθεί σημαντικά η χρήση του 

και όλο και περισσότεροι χρήστες αγοράζουν ηλεκτρονικά τα αγαθά τους. 

Το ηλεκτρονικό εμπόριο διακρίνεται σε έμμεσο και άμεσο. Έμμεσο είναι το 

ηλεκτρονικό εμπόριο το οποίο χρησιμοποιείται όταν πρόκειται για την ηλεκτρονική 

παραγγελία υλικών αγαθών που μπορούν να παραδοθούν με τον παραδοσιακό 

τρόπο. Άμεσο είναι το ηλεκτρονικό εμπόριο που περιλαμβάνει παραγγελία, πληρωμή 

και παράδοση αγαθών και υπηρεσιών. Η πληρωμή των υπηρεσιών αυτών γίνεται είτε 

με πιστωτικές κάρτες είτε με ηλεκτρονικό χρήμα. 

Όσο αφορά τους εμπλεκόμενους, υπάρχουν διάφοροι ταξινομήσεις του 

ηλεκτρονικού εμπορίου ανάλογα με τους φορείς μεταξύ των οποίων γίνονται οι 

συναλλαγές. Η σχετική βιβλιογραφία αναγνωρίζει μεταξύ άλλων τις ακόλουθες: 

 Επιχείρηση με επιχείρηση 

 Επιχείρηση με υπαλλήλους 

 Επιχείρηση με καταναλωτή 

 Καταναλωτή με καταναλωτή 

 Καταναλωτή με επιχείρηση 

 Διεπιχειρησιακό  

 Ενδο-επιχειρησιακό 

Κάθε μια από τις ως άνω κατηγορίες υποστηρίζεται με εξειδικευμένα μέσα και 

εφαρμογές που σήμερα δεσπόζουν στο διαδίκτυο.  
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Υπάρχουν πάρα πολλά πλεονεκτήματα για έναν καταναλωτή ο οποίος επιθυμεί να 

αγοράσει προϊόντα και υπηρεσίες μέσω του διαδικτύου. Τα πλεονεκτήματα αυτά 

αφορούν και την εταιρεία και είναι τα εξής: 

 Τα ηλεκτρονικά καταστήματα λειτουργούν όλο το 24ωρο , επομένως ο πελάτης 

μπορεί να πραγματοποιήσει κάποια αγορά οποιαδήποτε στιγμή. 

 Το κόστος των προϊόντων είναι πολύ μικρότερο.  

 Η αγορά είναι παγκόσμια. Ο αγοραστής μπορεί να αγοράσει προϊόντα τα οποία 

μπορεί να κυκλοφορούν μόνο στο εξωτερικό. 

 Ο καθένας μπορεί να βρει ότι θέλει χωρίς κανένα κόπο και σπατάλη χρόνου. 

 Η εταιρεία γίνεται πιο ανταγωνιστική αφού μπορεί να ενημερώνεται πιο εύκολα 

για τις τρέχουσες εξελίξεις στο χώρο της.  

 Μπορεί να κερδίζει πελάτες οι οποίοι βρίσκονται σε άλλη πόλη, ακόμα και στο 

εξωτερικό. 

 Μέσω των ηλεκτρονικών συναλλαγών η εταιρεία μπορεί να συλλέξει στοιχεία 

σχετικά με τις προτιμήσεις των καταναλωτών, τις συνήθειες τους, και τις ανάγκες 

τους με σκοπό τη βελτίωση της. 

Ως προς τα μειονεκτήματα του ηλεκτρονικού εμπορίου, αυτά αφορούν κυρίως 

θέματα όπως η ευχρηστία, ασφάλεια, κτλ. Ενδεικτικά αναφέρονται τα παρακάτω: 

 Δεν μπορεί να διασφαλιστεί με σιγουριά το απόρρητο των συναλλαγών και των 

προσωπικών δεδομένων. 

 Η αγορά είναι εικονική και δεν υπάρχει αμεσότητα με το αντικείμενο. 

 Ο καταναλωτής μπορεί να πέσει θύμα απάτης καθώς δεν είναι σίγουρος για το 

προϊόν που θέλει να αγοράσει, αν το ηλεκτρονικό κατάστημα υφίσταται και αν 

θα παραλάβει το προϊόν. 

 Με κάθε αγορά ενός προϊόντος συνήθως πληρώνουμε ένα αντίτιμο για την 

αποστολή του. 

 Για κάθε ασφάλεια θα πρέπει ο αγοραστής να έχει ένα μοναδικό κωδικό που να 

μην τον έχει χρησιμοποιήσει ξανά. 

2.2. Ηλεκτρονικά καταστήματα 

Σκοπός του ηλεκτρονικού καταστήματος είναι να παρέχει σε ηλεκτρονική μορφή όλες 

τις δυνατότητες που μπορεί να έχει ένα συμβατικό εμπορικό κατάστημα. Ειδικότερα, 

ένα ηλεκτρονικό κατάστημα θα πρέπει να δέχεται παραγγελίες, να κάνει εκπτώσεις, 

να υπολογίζει φόρους και όλα αυτά χωρίς την ανθρώπινη παρέμβαση. Το κόστος  

συντήρησης ενός ηλεκτρονικού καταστήματος είναι πολύ μικρό σε σχέση με το 

φυσικό κατάστημα και διαχείριση του δεν απαιτεί ιδιαίτερες προγραμματιστικές 

δεξιότητες ή εξειδικευμένες γνώσεις υπολογιστών. Το ηλεκτρονικό κατάστημα 
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μπορεί να λειτουργήσει είτε ως αυτόνομο κατάστημα είτε σε συνδυασμό με ένα 

κατάστημα για να αυξήσει τις πωλήσεις του. 

Για την κατασκευή ενός ηλεκτρονικού καταστήματος απαιτούνται οι παρακάτω 

λειτουργίες: 

 Ηλεκτρονικό καλάθι: Η λειτουργία του αφορά την αγοραπωλησία προϊόντων 

και υπηρεσιών , η παρακολούθηση των παραγγελιών καθώς και η ομαλή 

λειτουργία όλων των διεργασιών που καλείται να διεκπεραιώσει ένα 

ηλεκτρονικό κατάστημα 

 Σύστημα χρηματικών συναλλαγών: Αφορά την συνεργασία με κάποια 

τράπεζα για OnLine χρέωση  

 Σύστημα μεταφοράς και παράδοσης προϊόντων: Ως μέσω μεταφορά μπορεί 

να χρησιμοποιηθεί μια εταιρεία courier. Ορισμένα ηλεκτρονικά καταστήματα 

δίνουν τη δυνατότητα παραλαβής του προϊόντος από το ίδιο το κατάστημα 

Οι παραπάνω βασικές λειτουργίες επιτρέπουν σε ένα ηλεκτρονικό κατάστημα να 

φέρει εις πέρας σειρά πρόσθετων υπηρεσιών:  

 Άμεση ενημέρωση των πελατών για τα διαθέσιμα προϊόντα   
 Ευελιξία στον τρόπο πληρωμής 
 Αύξηση των πωλήσεων 
 Συνεχής λειτουργία 
 Βελτίωση τιμών των προϊόντων 
 Εύκολη διαχείριση 
 Ελάχιστο κόστος δημιουργίας 

2.3. e-marketplaces (ηλεκτρονικές αγορές) 

Οι ηλεκτρονικές αγορές (e-marketplaces) αναφέρονται στο σύνολο της διαδικασίας 

διαχείρισης παραγγελιών η οποία συνδέει άμεσα τους πελάτες με τους προμηθευτές 

και επιτρέπει στους συμμετέχοντες να ανταλλάσσουν πληροφορίες για τιμές, 

προσφορές προϊόντων και να συνεργάζονται μεταξύ τους μέσω πληροφοριακών 

συστημάτων και εργαλείων εμπορικής συνεργασίας. Ο κεντρικός ρόλος των e-

marketplaces είναι η εύκολη ανταλλαγή προϊόντων, αγαθών, υπηρεσιών και 

πληρωμών. Στην Ελλάδα τα πρώτα e-marketplaces εμφανίστηκαν το 2000 από τη 

Business Exchanges και την CosmoOne. Από τότε είναι φανερή η τάση αύξησης τους, 

γεγονός που δείχνει τη σημασία που δείχνουν οι επιχειρήσεις στην καθημερινή 

χρήση τους.  

Το χαρακτηριστικό γνώρισμα ενός electronic marketplace (βλέπε Σχήμα 1) είναι ότι 

φέρνει πολλούς αγοραστές και πωλητές μαζί σε ένα κεντρικό σημείο αγοράς. 
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Επιτρέπει επίσης σε αυτούς να αγοράσουν και να πωλήσουν ο ένας στον άλλον σε 

μια δυναμική τιμή που καθορίζεται σύμφωνα με τους κανόνες της ανταλλαγής. 

 

Σχήμα 1: Μια τυπική διάρθρωση μιας ηλεκτρονικής αγοράς 

Οι ηλεκτρονικές αγορές διακρίνονται σε τέσσερις διαφορετικές κατηγορίες : 

 Αγορές καθοδηγούμενες από αγοραστές (buyer-driven) 

 Αγορές καθοδηγούμενες από προμηθευτές (seller-driven) 

 Ανεξάρτητες αγορές (independent) 

 Αγορές καθοδηγούμενες από παρόχους τεχνολογικών εφαρμογών 

(technology providers) 

2.4. Διεπιχειρησιακά Συστήματα 

Μια ειδική κατηγορία ηλεκτρονικής αγοράς είναι αυτή που στοχεύει στο εμπλέξει 

φορείς / οργανισμούς στην από κοινού διεκπεραίωση στόχων (π.χ. ανταλλαγή 

προϊόντων, υπηρεσίες και πληροφορίας). Συνήθως, οι ηλεκτρονικές αγορές αυτής της 

κατηγορίας υποστηρίζονται από εξειδικευμένες λύσεις που ονομάζονται 

Διεπιχειρησιακά Συστήματα. Διεπιχειρησιακά Συστήματα ονομάζουμε λοιπόν, τα 

πληροφοριακά συστήματα τα οποία λειτουργούν μεταξύ δύο ή περισσότερων 

οργανισμών, συνδέοντας επιχειρήσεις μεταξύ τους καθώς και με τους πελάτες ή τους 

προμηθευτές. Στη διεθνή βιβλιογραφία τα Διεπιχειρησιακά Πληροφοριακά 

συστήματα αναφέρονται ως Inter-Organizational Systems(IOS) και απολογιείται με τη 

χρήση διάφορων τεχνικών που βασίζονται στην τεχνολογία Πληροφορικής και 

Τηλεπικοινωνιών. Οι κύριοι τύποι IOS είναι οι παρακάτω (βλέπε Σχήμα 2): 
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 Ηλεκτρονική ανταλλαγή δεδομένων (Electronic Data Interchange) 

 Ηλεκτρονικές αγορές 
 Λογισμικό Εφοδιαστικής αλυσίδας 
 Υπηρεσίες Διαδικτύου 
 Παγκόσμιος Ιστός 

 

Σχήμα 2: Διατάξεις διεπιχειρησιακών συστημάτων 

2.4.1. Electronic Data Interchange 

Η τεχνολογία EDI αφορά τη μεταφορά δεδομένων μεταξύ των οργανισμών , όπου τα 

δεδομένα μεταφέρονται από τον υπολογιστή του ενός οργανισμού στον υπολογιστή 

του άλλου χωρίς καμία ανθρώπινη παρέμβαση. Τα οφέλη του αφορούν τη μείωση 

του κόστους, των καθυστερήσεων και των λαθών. Επίσης βελτιώνεται η ικανοποίηση 

των πελατών μέσω της ποιοτικότερης εξυπηρέτησης και η βελτίωση της 

ανταγωνιστικής θέσης της επιχείρησης. 

2.4.2. Ηλεκτρονικές αγορές 

Οι Ηλεκτρονικές αγορές αποτελούν έναν τύπο IOS που επιτρέπει στους 

συμμετέχοντες αγοραστές και πωλητές να ανταλλάξουν πληροφορίες σχετικά με τις 

τιμές και προσφορές και να υπολογίσουν αγοραπωλησίες. Η ηλεκτρονική αγορά έχει 

τον ρόλο του μέσου όπου φέρνει σε επαφή πωλητές και αγοραστές προκειμένου να 

εκτελεστεί η αγοραπωλησία.  
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2.4.3. Λογισμικό Εφοδιαστικής αλυσίδας 

Το λογισμικό Διαχείρισης Εφοδιαστικής Αλυσίδας είναι μια εφαρμογή λογισμικού 

που βασίζεται στο διαδίκτυο και επιτρέπει στους εργαζόμενους να αγοράσουν 

προϊόντα ή υπηρεσίες σε συμφωνία με τους αγοραστικούς κανόνες της επιχείρησης, 

ενώ παράλληλα καταχωρεί δεδομένα που σχετίζονται με τη διεργασία της 

αγοραπωλησίας.  

2.4.4. Υπηρεσίες Διαδικτύου 

Οι μεμονωμένες επιχειρήσεις αντικαθιστώνται από δίκτυα συνεργαζόμενων μεταξύ 

τους επιχειρήσεων στα πλαίσια των οποίων ο κάθε συμμετέχων παρέχει στους 

υπόλοιπους εξειδικευμένες υπηρεσίες. Δίνει τη δυνατότητα ολοκλήρωσης 

εφαρμογών και επιχειρησιακών διεργασιών τόσο εντός ενός οργανισμού όσο και 

ανάμεσα σε διαφορετικούς οργανισμούς. 

2.5. Διεπιχειρησιακά Συστήματα και ηλεκτρονικό εμπόριο 

Είναι κρίσιμο στο σημείο αυτό να αναφερθούμε επιλεκτικά σε ορισμένες από τις 

διαφορές που προβάλλουν τα διεπιχειρησιακά συστήματα σε σχέση με το κλασικό 

ηλεκτρονικό εμπόριο. Πρώτα από όλα στα Διεπιχειρησιακά Συστήματα η σχέση 

πελάτη/προμηθευτή είναι προκαθορισμένη σε αντίθεση με το ηλεκτρονικό εμπόριο 

όπου η σχέση προμηθευτή/πελάτη δημιουργείται τη στιγμή που πραγματοποιείται η 

συναλλαγή. Δεύτερον, τα Διεπιχειρησιακά Συστήματα πραγματοποιούνται σε 

ιδιωτικά ή δημόσιας πρόσβασης δίκτυα ενώ οι ηλεκτρονικές αγορές 

πραγματοποιούνται αποκλειστικά σε δίκτυα δημόσιας πρόσβασης. Τρίτον, στα 

Διεπιχειρησιακά Συστήματα υπάρχει κοινή πορεία και προσδοκίες ώστε κάθε πλευρά 

να γνωρίζει πως λειτουργεί το σύστημα. Στις ηλεκτρονικές αγορές δεν υπάρχει 

κάποια κοινή πορεία μεταξύ των εμπλεκομένων οι οποίοι διατηρούν απόλυτη 

αυτονομία ως προς το πώς υλοποιούν εσωτερικές διεργασίες. Τέταρτον, στα 

Διεπιχειρησιακά Συστήματα οι εξωτερικές εταιρίες επικοινωνιών είναι φορείς 

προστιθέμενης αξίας, ενώ στις ηλεκτρονικές αγορές είναι συνήθως παροχείς online 

υπηρεσιών. Με βάση τα παραπάνω, είναι δυνατόν τώρα να κωδικοποιήσουμε τα 

πλεονεκτήματα των διεπιχειρησιακών συστημάτων ως προς μια σειρά κριτηρίων που 

αφορούν: 

 την βελτίωση της διαδικασίας αγοράς (π.χ. μείωση κόστους αγοράς, μείωση 

κόστους συναλλαγής, πληρωμή στην πραγματική τιμή του προϊόντος, μεγαλύτερη 

διαφάνεια κατά την τιμολόγηση, κ.λπ.) 

 την βελτίωση της Διεπιχειρησιακής Συνεργασίας (π.χ. δυνατότητα αναζήτησης 

πληροφοριών σχετικών με την διαθεσιμότητα των προϊόντων, μείωση του χρόνου 

μεταξύ παραγγελίας προϊόντων και παράδοσής τους, αποτελεσματικότερη 



Πτυχιακή : Ανάλυση συστημάτων διεπιχειρησιακής συνεργασίας στο διαδίκτυο 
 

 Σελίδα 15 
 

μεταφορά προϊόντων ή πρώτων υλών, βελτίωση διαχείρισης των αποθεμάτων, 

βελτίωση της συνεργασίας με τους προμηθευτές, κ.λπ.) 

Όσο αφορά την επιλογή του κατάλληλου IOS για τις διάφορες οργανώσεις είναι 

ανάγκη να γνωρίζουμε ποιά είδη είναι διαθέσιμα. Στη βιβλιογραφία αναφέρονται 

τρείς τύποι/διατάξεις (βλέπε Σχήμα 3): 

 Ηλεκτρονικές δυάδες: Κάθε προμηθευτής θεσπίζει μεμονωμένα των διμερών 

σχέσεων των συναλλαγών με κάθε μία από μια ομάδα πελατών για ένα προϊόν ή 

υπηρεσία. Το Σχήμα 3 δείχνει ένα παράδειγμα ενός ηλεκτρονικού IOS δυάδας 

ανάμεσα σε πέντε προμηθευτές και τους πελάτες. 

 Πολυμερές IOS: Χρησιμεύει ως ενδιάμεσος μεταξύ ενός οργανισμού και την 

ανταλλαγή των εταίρων. Υπάρχουν δύο υποκατηγορίες των πολυμερών IOS: 

o Ηλεκτρονική Αγορά : Επιτρέπει πολλούς προμηθευτές και πελάτες να 

επικοινωνούν πάνω σε ένα ενιαίο IOSs (Σχήμα 3α) 

o Σύστημα πωλήσεων εκπομπής : Αναπτύσσεται συνήθως από ένα πελάτη 

(Σχήμα 3b) 

 Ηλεκτρονικό μονοπώλιο: Ένα ηλεκτρονικό μονοπώλιο IOS υποστηρίζει μια ενιαία 

σχέση πηγή για ένα προϊόν η μια σειρά από προϊόντα.  

 

(α) Ηλεκτρονικές δυάδες 

 

Σχήμα 3: Διατάξεις IOS 
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3. Ηλεκτρονικοί συνεταιρισμοί, συμμαχίες και 

δίκτυα 

3.1. Εφοδιαστική Αλυσίδα 

Ως εφοδιαστική αλυσίδα ορίζεται η ροή των πληροφοριών, των προϊόντων, των 

πρώτων υλών και των χρημάτων από τους προμηθευτές στους πελάτες. Στόχος μιας 

επιχείρησης είναι η προσθήκη αξίας στα προϊόντα τους καθώς αυτά διέρχονται μέσω 

της εφοδιαστικής αλυσίδας και η μεταφορά τους στις κατάλληλες ποσότητες, με τις 

απαιτούμενες προδιαγραφές, στον κατάλληλο χρόνο. 

Η διαχείριση της εφοδιαστικής αλυσίδας ασχολείται με το σχεδιασμό και όλες τις 

απαραίτητες ενέργειες που σχετίζονται με την προμήθεια, την παραγωγή και τη 

διανομή. Επίσης περιλαμβάνει το συντονισμό και τη συνεργασία μεταξύ των εταίρων 

όπως για παράδειγμα των προμηθευτών, των μεσαζόντων και των εταιριών παροχής 

υπηρεσιών. Συμπεραίνουμε λοιπόν ότι σκοπός της εφοδιαστικής αλυσίδας είναι η 

ολοκλήρωση στον τομέα του σχεδιασμού, της μεταφοράς, αποθήκευσης, πωλήσεων 

παραγωγής, αποθήκευσης και των προμηθευτών. 

Ο λόγος που οι εταιρίες εμπλέκονται στις στρατηγικές διαχείρισης της εφοδιαστικής 

αλυσίδας είναι η αύξηση του κέρδους κατά μήκος της εφοδιαστικής αλυσίδας το 

οποίο σημαίνει κέρδος για όλες τις επιχειρήσεις που συμμετέχουν σε αυτήν. Η 

κερδοφορία αυτή επιτυγχάνεται με την ικανοποίηση των αναγκών των πελατών , 

στον κατάλληλο χρόνο, προσφέροντας προϊόντα υψηλής προστιθέμενης αξίας. 

3.2. Συμμαχίες (alliances) 

Οι στρατηγικής συμμαχίες μεταξύ των επιχειρήσεων είναι πλέον ένα συχνό 

φαινόμενο. Ο πολλαπλασιασμός τους έχει οδηγήσει σε πολλές έρευνες και μελέτες 

προσπαθώντας να εξεταστούν μερικές από τις αιτίες και τις συνέπειες. Σε αυτό το 

άρθρο θα εξετάσουμε το πως αυτή η προοπτική επηρεάζει τη συμπεριφορά και τις 

επιδόσεις των επιχειρήσεων. 

Ως στρατηγικές συμμαχίες ορίζονται οι εθελοντικές συμφωνίες μεταξύ των 

επιχειρήσεων που αφορούν την ανταλλαγή ή την κοινή ανάπτυξη των προϊόντων, 

τεχνολογιών ή υπηρεσιών με την αποτελεσματική διαχείριση της εφοδιαστικής 

αλυσίδας. Αφορούν την ανταλλαγή γνώσεων και τεχνογνωσίας μεταξύ των εταιριών 

και η μείωση του κινδύνου και του κόστους σε τομείς όπως οι σχέσεις με τους 

προμηθευτές και η ανάπτυξη νέων προϊόντων και τεχνολογιών. Μια στρατηγική 

συμμαχία ταυτίζεται πολλές φορές με μια κοινή επιχείρηση αλλά μια συμμαχία 

μπορεί να περιλαμβάνει ανταγωνιστές και γενικά να έχει μικρότερη διάρκεια ζωής. 



Πτυχιακή : Ανάλυση συστημάτων διεπιχειρησιακής συνεργασίας στο διαδίκτυο 
 

 Σελίδα 17 
 

Οι στρατηγικές συμμαχίες αποτελούν σημαντική μορφή επιχειρηματικής 

δραστηριότητας σε πολλούς κλάδους, ιδιαίτερα ενόψει του αυξανόμενου 

ανταγωνισμού σε παγκόσμιο επίπεδο. Μέσω των στρατηγικών συμμαχιών, οι 

εταιρίες μπορούν να βελτιώσουν την ανταγωνιστική τους θέση, να αποκτήσουν 

πρόσβαση σε νέες αγορές και να μοιραστούν τον κίνδυνο και το κόστος των μεγάλων 

αναπτυξιακών έργων. Οι στρατηγικές συμμαχίες έχουν ορισμένα κοινά 

χαρακτηριστικά: 

 Δύο ή περισσότερες οργανώσεις κάνουν μια συμφωνία για την επίτευξη των 

στόχων με κοινό συμφέρον  

 Οι εταίροι μοιράζονται τόσο τα πλεονεκτήματα όσο και τον έλεγχο της 

διαχείρισης της συμμαχίας  

 Οι εταίροι συνεισφέρουν με δικούς τους πόρους και δυνατότητες για την 

ανάπτυξη ενός ή περισσότερους τομείς της συμμαχίας. 

3.3. Συνεταιρισμοί (partnerships) 

Ένας συνεταιρισμός είναι μία διάταξη στην οποία τα μέρη συμφωνούν να 

συνεργαστούν για την προώθηση των αμοιβαίων συμφερόντων τους. Σχηματίζεται 

όταν δυο ή περισσότεροι εταίροι επιθυμούν να έρθουν σε μεταξύ τους συνεργασία 

για να σχηματίσουν μια επιχείρηση. Είναι ένας τρόπος σκέψης, μια νοοτροπία, μια 

επιστήμη. Οι εταιρικές σχέσεις αυτού του τύπου προκαλούν δέσμευση των εταίρων 

σε κοινό στόχο με σκοπό να εξαλείψουν κινδύνους και να ενθαρρύνουν τα 

συναισθήματα της ιδιοκτησίας, της συν-ευθύνης και του κοινού τόπου. Μπορεί να  

βοηθήσει τους ανθρώπους να αναγνωρίσουν τα προβλήματα με σαφήνεια και να 

τους επιτρέψει να βρουν καλύτερες λύσεις. Στις τοπικές καταστάσεις , οδηγεί σε 

αμοιβαίο σεβασμό σε όλες τις ηλικιακές ομάδες και σε όλους τους τομείς και τα 

επίπεδα της κοινωνίας. Οι οργανωτικές συνεργασίες ορίζονται ως συνεταιρισμός, 

συνεργατικών σχέσεων που υπάρχουν μεταξύ δύο ή περισσοτέρων ανεξάρτητων μη 

κερδοσκοπικών οργανισμών για την αύξηση της διοικητικής αποτελεσματικότητας. 

Οι διάφοροι τύποι εταιρικών σχέσεων μπορούν να εστιάζουν είτε στη συνεργασία 

είτε στο  (δηλ. σύναψη σχέσεων με στόχο την υλοποίηση έργων κοινού συμφέροντος) 

είτε στο συντονισμός (δηλ. σύναψη σχέσεις που βασίζονται στον  από κοινού 

σχεδιασμό, την κατανομή των ρόλων και των πόρων και τα συνεπή κανάλια 

επικοινωνίας). Θα πρέπει ωστόσο να σημειωθεί ότι οι επιτυχής οργανωτικές 

συνεργασίες περιλαμβάνουν, αλλά δεν περιορίζονται μόνο στα παραπάνω 

χαρακτηριστικά. Οργανωτική σύμπραξη συνεπάγεται σημαντική δραστηριότητα , η 

οποία μπορεί να περιλαμβάνουν προσπάθειες για τη δημιουργία κοινών στόχων , τη 

συγκέντρωση πόρων, από κοινού σχεδιασμό, την εφαρμογή και την αξιολόγηση των 

υπηρεσιών.  

Σε περιπτώσεις που ένας συνεταιρισμός είναι επιτυχής μπορεί να αποφέρει 

πολλαπλά πλεονεκτήματα στα οποία συμπεριλαμβάνονται: 
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 Κεφάλαιο – Λόγω της φύσης της επιχείρησης , οι εταίροι θα χρηματοδοτήσουν 

την επιχείρηση με κεφάλαιο εκκίνησης . Αυτό σημαίνει ότι οι περισσότεροι 

εταίροι , τα περισσότερα χρήματα που μπορούν να βάλουν στην επιχείρηση θα 

επιτρέψουν μεγαλύτερη ευελιξία και περισσότερες δυνατότητες για ανάπτυξη . 

Σημαίνει επίσης πιο πιθανό κέρδος , το οποίο θα κατανέμεται εξίσου μεταξύ των 

εταίρων. 

 Συνυπευθυνότητα – Οι συνεργάτες μπορούν να μοιράζονται την ευθύνη για τη 

λειτουργία της επιχείρησης. Αυτό θα τους επιτρέψει να αξιοποιήσουν στο έπακρο 

τις δυνατότητες τους. Αντί για το διαχωρισμό της διαχείρισης μπορούν κάλλιστα 

να χωρίσουν την εργασία σύμφωνα με τις ικανότητές τους . Έτσι, αν ένας εταίρος 

είναι καλοί με τους αριθμούς , μπορεί να ασχοληθεί με την τήρηση βιβλίων και 

λογαριασμών, ενώ ο άλλος εταίρος μπορεί ασχοληθεί τις πωλήσεις και ως εκ 

τούτου να είναι το κύριο πρόσωπο πωλήσεων για την επιχείρηση. 

 Λήψη Αποφάσεων – Οι εταίροι μοιράζονται την λήψη αποφάσεων και μπορεί να 

βοηθήσει ο ένας τον άλλον, όταν χρειάζεται. Περισσότεροι συνεργάτες σημαίνει 

περισσότερα μυαλά που μπορούν να χρησιμοποιηθούν για επιχειρηματικές ιδέες 

και για την επίλυση των προβλημάτων που οι επιχειρηματικές συναντούν . 

Ωστόσο, η βιβλιογραφία αναφέρει και αρκετού κινδύνους που εμπεριέχονται σε 

εγχειρήματα δημιουργίας συνεταιρισμών και οι οποίοι θα πρέπει να λαμβάνονται 

υπόψη. Μεταξύ αυτών είναι και οι παρακάτω: 

 Διαφωνίες – Ένα από τα πιο προφανή μειονεκτήματα της εταιρικής σχέσης είναι 

ο κίνδυνος των διαφωνιών μεταξύ των εταίρων . Προφανώς οι άνθρωποι είναι 

πιθανό να έχουν διαφορετικές ιδέες για το πώς η επιχείρηση θα πρέπει να τρέξει. 

Αυτό μπορεί να οδηγήσει σε διαφωνίες και διαφορές που θα μπορούσαν να 

βλάψουν όχι μόνο την επιχείρηση , αλλά και τη σχέση των εμπλεκομένων .  

 Κέρδη – Οι εταίροι μοιράζονται τα κέρδη εξίσου. Αυτό μπορεί να οδηγήσει σε 

ασυνέπεια , όπου ένας ή περισσότεροι εταίροι δεν βάζουν ένα δίκαιο μερίδιο της 

προσπάθειας για τη λειτουργία ή τη διαχείριση της επιχείρησης . 

 Ευθύνη – Η τακτική των εταιρειών υπόκεινται σε απεριόριστη ευθύνη , πράγμα 

που σημαίνει ότι κάθε ένας από τους εταίρους μοιράζεται την ευθύνη και τους 

κινδύνους της επιχείρησης το οποίο μπορεί να είναι απωθητικό για μερικούς 

ανθρώπους. Αυτό μπορεί να αντιμετωπιστεί με τη δημιουργία μιας 

περιορισμένης ευθύνης .  

Σε γενικές γραμμές, εδώ είναι μερικά από τα πιο κοινά οφέλη και τις προφυλάξεις 

των στρατηγικών συμμαχιών και συνεργασιών:  

 Μπορεί να επωφεληθούμε από τις μεμονωμένες δυνάμεις του κάθε 

συμμετέχοντα οργανισμό.  

 Αφορά την κοινή ευθύνη για την ανάπτυξη και την εκτέλεση ενός συγκεκριμένου 

προγράμματος ή υπηρεσίας.  

 Παρέχει ευκαιρίες με μειωμένο κόστος και την εμπειρία για κάθε συμμετέχοντα 

οργανισμό. 
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Μερικές προφυλάξεις ή προκλήσεις που ένας οργανισμός μπορεί να συναντήσει στην 

επιδίωξη στρατηγικών συμμαχιών ή συνεργασιών περιλαμβάνουν: 

 Μπορεί να καταστεί αναποτελεσματική, αν ένας εταίρος δεν αποδίδει στο 

αναμενόμενο επίπεδο ή δεν εκπληρώνει τις υποχρεώσεις της προς τη συμφωνία. 

 Μπορεί να απαιτήσει μια σημαντική επένδυση χρόνου να αναπτυχθεί μια 

αποτελεσματική συμμαχία ή συνεργασία. 

 Μπορεί να καταναλώσει περισσότερους ανθρώπινους και οικονομικούς πόρους 

από ό, τι είχαν προβλεφθεί. 

3.4. Δίκτυα (Networks) 

Το δίκτυο παίζει πολύ σημαντικό ρόλο στην επιχείρηση καθώς παρέχει τη δυνατότητα 

τα δεδομένα που αφορούν τη ζήτηση να είναι ορατά σε όλες τις επιχειρήσεις με 

σκοπό τον έλεγχο των διακυμάνσεων ζήτησης και την κατάλληλη ανταπόκριση. Έχει 

επηρεάσει όλες τις περιοχές λειτουργιών της επιχειρήσεις όπως τη μεταφορά, τη 

διαχείριση των αποθεμάτων, καθώς και τον τρόπο με τον οποίο οι επιχειρήσεις 

προμηθεύονται τα προϊόντα. Ένα πολύ σημαντικό πλεονέκτημα των δικτύων στον 

τομέα των επιχειρήσεων αφορά τις προμήθειες. Έχει βοηθήσει σημαντικά στη 

μείωση του εργατικού κόστους λόγω της μείωσης του μεγέθους των τμημάτων 

προμηθειών, καθώς οι OnLine κατάλογοι πωλήσεων επιτρέπουν την άμεση διάθεση 

προϊόντων και υπηρεσιών χωρίς τη χρήση ενός τμήματος προμηθειών. 
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4. Τεχνολογίες και Εργαλεία Ανάπτυξης 

4.1. Ορολογία και τεχνολογίες του διαδικτύου 

Ο ιστότοπος είναι το σύνολο των ιστοσελίδων που είναι συνδεδεμένες μεταξύ τους 

με υπερσυνδέσεις και περιγράφουν μια δραστηριότητα. Ένας ιστότοπος μπορεί να 

είναι προσωπικός, να ανήκει σε ένα οργανισμό ή σε μια ομάδα. Το σύνολο των 

ιστοτόπων που υπάρχουν απαρτίζουν στην ουσία τον Παγκόσμιο Ιστό (www). Οι 

ιστότοποι απαρτίζονται από ιστοσελίδες. Μια ιστοσελίδα είναι ένα αρχείο που 

περιέχει πληροφορίες συνήθως γραμμένες σε HTML ή XHTML, οι οποίες είναι 

περιορισμένες ως προς τη δημοσίευση στον Παγκόσμιο Ιστό(www). Μια ιστοσελίδα 

είναι προσβάσιμη με τη βοήθεια ενός φυλλομετρητή (Web Browser). Οι Web 

Browsers είναι προγράμματα τα οποία μας επιτρέπουν να βλέπουμε ιστοσελίδες στο 

Internet. Κάθε ένας Web Browser έχει τις δικές του δυνατότητες. Οι πιο δημοφιλείς 

Web Browsers είναι οι Internet Explorer, Google Chrome, Mozilla Firefox και AVANT 

Browser. Το κύριο χαρακτηριστικό όλων είναι ότι διανέμονται δωρεάν οπότε ο 

χρήστης μπορεί να επιλέξει αυτόν που καλύπτει τις ανάγκες του.  

Τα Domain Names είναι ουσιαστικά οι ταυτότητες των ιστοσελίδων. Όταν θέλουμε 

να καλέσουμε μια ιστοσελίδα μέσα από ένα Web Browser θα πρέπει να γράψουμε 

στη γραμμή διευθύνσεων το όνομα της. Γράφοντας αυτό το όνομα ο Web Browser  

ψάχνει να βρει σε ποιο Web Server είναι αποθηκευμένη η συγκεκριμένη σελίδα. Εάν  

υπάρχει το συγκεκριμένο Domain Name τότε ο Web Browser θα εμφανίσει τη 

συγκεκριμένη ιστοσελίδα. Μια ιστοσελίδα για να μπορεί να λειτουργεί θα πρέπει να 

είναι αποθηκευμένη σε έναν Web Server. Ένας Web Server αποτελεί ουσιαστικά ένα 

είδος υποδοχέα ιστοσελίδων, υπεύθυνος να δημοσιεύσει την ιστοσελίδα στο 

διαδίκτυο. Υπάρχουν δυο βασικοί Web Server – ο Apache που συνήθως χρησιμοποιεί 

λειτουργικό σύστημα Linux και ο IIS που χρησιμοποιεί λειτουργικό σύστημα 

Windows.  

Οι ιστοσελίδες που δημοσιεύονται από ένα web server είναι συνήθως δύο τύπων – 

στατικές ή δυναμικές. Ο χαρακτηρισμός "στατική", αποδίδει την έννοια ότι το 

περιεχόμενο της σελίδας παραμένει σταθερό και συγκεκριμένο. Οι ιστοσελίδες αυτής 

της κατηγορίας είναι στην πραγματικότητα σταθερά ηλεκτρονικά έγγραφα. Οι 

στατικές ιστοσελίδες είναι πολύ εύκολες στην κατασκευή τους αλλά πολύ δύσκολες 

στην ανανέωση τους. Αυτό συμβαίνει γιατί όταν θέλουμε να προσθέσουμε ή να 

αλλάξουμε το περιεχόμενο τους, πρέπει να ανοίξουμε το κατάλληλο πρόγραμμα και 

αφού κάνουμε τις αλλαγές που θέλουμε και τις αποθηκεύσουμε να ανεβάσουμε στον 

Web Server  τις νέες σελίδες με τις αλλαγές. Για παράδειγμα αν θέλουμε να 

αλλάξουμε το όνομα ενός στοιχείου μενού σε όλες τις σελίδες, θα πρέπει να 

ανοίγουμε κάθε σελίδα, να αλλάζουμε το όνομα, να τις αποθηκεύουμε και στη 

συνέχεια να τις ανεβάζουμε στον Web Server. Όλο αυτό  προϋποθέτει πολλές γνώσεις 
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και φυσικά περισσότερο χρόνο. Ορισμένα από τα πλεονεκτήματα στατικών 

ιστοσελίδων περιλαμβάνουν τη γρήγορη ανάπτυξη, το χαμηλό κόστος ανάπτυξης, 

ελάχιστες προ απαιτούμενες δεξιότητες για να δημιουργήσει κάποιος μια ιστοσελίδα 

καθώς και το γεγονός ότι είναι φιλικές προς τις μηχανές αναζήτησης. Υπάρχουν, 

ωστόσο και μειονεκτήματα στις στατικές ιστοσελίδες που σχετίζονται με τα 

ακόλουθα το ότι χρησιμοποιούνται κυρίως όταν το περιεχόμενο είναι μικρό και δεν 

επιδέχεται συχνή ανανέωση. Επίσης, υπάρχει εγγενής δυσκολία διαχείρισης μεγάλου 

αριθμού στατικών ιστοσελίδων. 

Σε αντίθεση με τις στατικές ιστοσελίδες, οι δυναμικές ιστοσελίδες δε δημιουργούνται 

στον υπολογιστή μας αλλά κατευθείαν στον Web Server. Έχουμε τη δυνατότητα με 

τις κατάλληλες εντολές να αλλάξουμε τις ιστοσελίδες, να τις διαγράψουμε και να 

προσθέσουμε νέες. Συνήθως, οι δυναμικές ιστοσελίδες, χρησιμοποιούν κάποια βάση 

δεδομένων, όπου αποθηκεύουν πληροφορίες και απ' όπου αντλούν το περιεχόμενό 

τους. Η χρήση των βάσεων δεδομένων, είναι αυτή που επιτρέπει την εύκολη 

προσθαφαίρεση περιεχομένου στις δυναμικές ιστοσελίδες, καθώς δεν απαιτείται να 

επεξεργάζεται κανείς κάθε φορά την ίδια την ιστοσελίδα, αλλά απλά να διαχειρίζεται 

έμμεσα το περιεχόμενο στην βάση δεδομένων. Γενικά, αυτό που προσφέρουν οι 

δυναμικές ιστοσελίδες, είναι μεγαλύτερη αλληλεπίδραση του χρήστη με την σελίδα 

αλλά και πολλές ευκολίες στον διαχειριστή του περιεχομένου της ιστοσελίδας  

Τα βασικά πλεονεκτήματα των δυναμικών ιστοσελίδων περιλαμβάνουν (α) 

δυνατότητα άμεσης επέμβασης και τροποποίησης ιστοσελίδας από το διαχειριστή 

(β) δεν υπάρχει περιορισμός στον όγκο που μπορεί να αποκτήσει ένας ιστότοπος (γ) 

πολύ μικρό κόστος συντήρησης και ανανέωσης σε σχέση με τη στατική διότι δεν 

χρειάζεται να πληρώσουμε την εταιρία που την κατασκεύασε, για τις αλλαγές που 

επιθυμούμε και (δ) αυξημένες περισσότερες δυνατότητες σε σχέση με τις στατικές 

όπως για παράδειγμα αναζήτηση, εγγραφή χρηστών κτλ. Από τη άλλη πλευρά, στα 

μειονεκτήματα πρέπει να καταγραφούν η πρόσθετη πολυπλοκότητα στο σχεδιασμό 

και την κατασκευή, ο επιπλέον χρόνος και κόστος που απαιτείται για την κατασκευή 

μιας δυναμικής ιστοσελίδας και ο πρόσθετος αποθηκευτικός χώρος. 

4.2. Γλώσσες προγραμματισμού και σήμανσης 

Η ανάπτυξη εφαρμογών στο διαδίκτυο βασίζεται σε διαφορετικές κατηγορίες 

τεχνολογιών και εργαλείων. Μεταξύ αυτών, οι γλώσσες προγραμματισμού και οι 

γλώσσες σήμανσης αποτελούν αναπόσπαστο συστατικό των περισσοτέρων 

διαδικτυακών. Ακολούθως θα αναφερθούμε ενδεικτικά και κάποια εργαλεία 

αξιοποιήθηκαν στο πλαίσιο της παρούσας διπλωματικής εργασίας, χωρίς ωστόσο να 

διεκδικούμε λεπτομερή κάλυψη των θεμάτων. 
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4.2.1. Η γλώσσα PHP 

 

Η PHP είναι μια γλώσσα προγραμματισμού που σχεδιάστηκε για τη δημιουργία 

δυναμικών ιστοσελίδων στο διαδίκτυο. Είναι μια γλώσσα που γράφεται στο 

διακομιστή και είναι συνήθως πλαισιωμένη από HTML για μορφοποίηση των 

αποτελεσμάτων. Σε αντίθεση με μια συνηθισμένη HTML σελίδα, η σελίδα PHP δε 

στέλνεται άμεσα σε ένα πελάτη(client), αλλά πρώτα αναλύεται και μετά 

αποστέλλεται το παραγόμενο αποτέλεσμα. Ο PHP κώδικας μπορεί να θέσει 

ερωτήματα σε βάσεις δεδομένων, να δημιουργήσει εικόνες, να διαβάσει και να 

γράψει αρχεία, να συνδεθεί με απομακρυσμένους υπολογιστές κτλ. 

Αρχικά η ονομασία της PHP ήταν PHP/FI η οποία δημιουργήθηκε το 1995 από τον 

Rasmus Lerdorf ως μια συλλογή από Perl scripts που τα χρησιμοποιούσε στην 

προσωπική του σελίδα. Δεν άργησε να τα εμπλουτίσει με λειτουργίες επεξεργασίας 

δεδομένων με SQL, αλλά τα σημαντικά βήματα που έφεραν και τη μεγάλη αποδοχή 

της PHP ήταν αρχικά η μετατροπή τους σε γλώσσα C. Αργότερα την ίδια χρονιά οι 

Andi Gutmans και Zeev Suraski ξαναέγραψαν τη γλώσσα από την αρχή, βασιζόμενοι 

όμως αρκετά στην PHP/FI 2.0. Έτσι η PHP έφθασε στην έκδοση 3.0 η οποία θύμιζε 

περισσότερο τη σημερινή μορφή της. Στη συνέχεια, οι Zeev και Andi δημιούργησαν 

την εταιρεία Zend (από τα αρχικά των ονομάτων τους), η οποία συνεχίζει μέχρι και 

σήμερα την ανάπτυξη και εξέλιξη της γλώσσας PHP. 

Μερικά από τα πλεονεκτήματα που καθιστούν την PHP δημοφιλή περιλαμβάνουν το 

χαμηλό κόστος, την υψηλή απόδοση, την ευκολία μάθησης και χρήσης, τη 

μεταφερσιμότητα, τη διαθεσιμότητα του κώδικα προέλευσης, τις ενσωματωμένες 

βιβλιοθήκες για πολλές Web εφαρμογές και τις διασυνδέσεις με πολλά διαφορετικά 

συστήματα βάσεων δεδομένων.  

4.2.2. HTML 

Τα αρχικά HTML προέρχονται από τις λέξεις HyperText Markup Language. Η HTML 

δεν είναι γλώσσα προγραμματισμού, αφού δεν έχει τα στοιχεία που χρειάζονται για 

να χαρακτηριστεί έτσι. b. Ανακαλύφτηκε από την IBM, η οποία ήθελε να λύσει το 

πρόβλημα της για μη τυποποιημένη εμφάνιση κειμένων στα διάφορα υπολογιστικά 

της συστήματα. HTML υπάρχει και στις δυναμικές και στις στατικές ιστοσελίδες. Η 

HTML μας βοηθάει να περιγράψουμε, με τα διάφορα δεδομένα tags (ετικέτες) που 

περιλαμβάνει , το πώς θέλουμε να εμφανίζεται το κείμενο  μας. Το κείμενο και οι 

ετικέτες δίνουν εντολές στον browser και αυτός με τη σειρά του απεικονίζει τα 

αποτελέσματα αυτών των εντολών στις οθόνες μας. Κάθε HTML αρχείο αποτελείται 

από ένα στοιχείο <html> το οποίο χωρίζεται σε δύο μέρη το<head> και <body>. Οπότε 
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το παράδειγμα της HTML που ακολουθεί θα επιτρέψει την παρουσίαση που 

εμφανίζεται στο Σχήμα 4. 

<HTML>  

 <HEAD>  

<TITLE>Sample</TITLE>  

</HEAD>  

<BODY>  

<H1><B>TEI ΚΡΗΤΗΣ</B></H>  

<BR> <H2><B>ΣΧΟΛΗ : ΣΤΕΦ</B></H>  

<BR> <H3><B><I>ΤΜΗΜΑ : ΕΦΑΡΜΟΣΜΕΝΗΣ ΠΛΗΡΟΦΟΡΙΚΗΣ ΚΑΙ ΠΟΛΥΜΕΣΩΝ</I></B></H>  

<BR> <H4><B><I>ΜΕΛΑ ΔΗΜΗΤΡΑ </I></B></H>  

</ΒODY> 

 </HTML> 

 

Σχήμα 4: Παράδειγμα χρήσης html κώδικα 

4.2.3. CSS 

Το ακρωνύμιο CSS προέρχονται από τον όρο Cascading Style Sheets. Τα CSS μας 

επιτρέπουν να διαχωρίσουμε το περιεχόμενο της σελίδας από το σχεδιαστικό 

κομμάτι. Αυτό είναι πολύ σημαντικό αφού τα στοιχεία σχεδίασης της ιστοσελίδας θα 

είναι σε ένα ξεχωριστό αρχείο το οποίο θα τροφοδοτεί τις υπόλοιπες σελίδες. Έτσι αν 

χρειαστεί να κάνουμε κάποια αλλαγή, όπως για παράδειγμα να αλλάξουμε το φόντο 

των σελίδων, το μόνο που έχουμε να κάνουμε είναι να επέμβουμε στο αρχείο CSS και 

αυτόματα οι αλλαγές θα επηρεάσουν όλα τα αρχεία τα οποία συνδέονται με αυτό. Η 

HTML  χρησιμοποιείται για να δομήσει το περιεχόμενο, ενώ το  CSS για να το 

μορφοποιήσει. Τα βασικά πλεονεκτήματα των  CSS είναι:  

 Διαχωρισμός του περιεχομένου από τη σχεδίαση 

 Ελαχιστοποίηση του χρόνου για την αλλαγή στις σελίδες αφού όλα τα αρχεία 

βρίσκονται σε ένα αρχείο. 

 Περισσότερο καθαρός κώδικας  HTML. 

 Αυξημένη ταχύτητα εμφάνισης της ιστοσελίδας. 

 Μικρότερο μέγεθος αρχείων. 

 Προσβασιμότητα από όλους τους Web Browsers. 

 Η CSS είναι σχετικά πολύ εύκολη γλώσσα στην εκμάθησή της. 

 Έχει πιστοποιηθεί από τον W3C , το μεγαλύτερο οργανισμό Web Standards. 
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4.2.4. XML                                                                      

Η XML είναι μια γλώσσα σήμανσης που σχεδιάστηκε για να ικανοποιεί πολλαπλές 

ανάγκες τις οποίες αδυνατεί η HTML. Μια  γλώσσα σήμανσης είναι ένα σύνολο 

εντολών που επιτρέπουν την εισαγωγή πληροφορίας στο περιεχόμενο μιας πηγής 

δεδομένων. Το περιεχόμενο μπορεί να είναι κείμενο, εικόνα ή μια άλλη μορφή 

ηλεκτρονικής πληροφορίας. Οι εντολές είναι απλές και κατανοητές και ονομάζονται 

tags. Συνεπώς μπορεί να χρησιμοποιηθεί εύκολα και από χρήστες οι οποίοι δεν είναι 

προγραμματιστές. Η XML συμπληρώνει και δεν αντικαθιστά την HTML. Ενώ η HTML 

χρησιμοποιείται για διατύπωση και εμφάνιση των δεδομένων, η  XML αναπαριστά τη 

συναφή έννοια των δεδομένων. Το ιδιαίτερο χαρακτηριστικό της XML είναι ότι 

επεκτείνεται και είναι ανεξάρτητη συστήματος λογισμικού. 

4.3. Συστήματα Διαχείρισης Περιεχομένου (CMS)  

Τα Συστήματα Διαχείρισης Περιεχομένου (CMS) αποτελούν εφαρμογές που 

επιτρέπουν στον χρήστη τους να δημιουργήσει, να διαχειριστεί και να δημοσιεύσει 

ιστοσελίδες στο διαδίκτυο. Τα CMS σήμερα αξιοποιούνται ευρέως σε ένα πλήθος 

πεδίων όπως ανάπτυξη καταλόγων προϊόντων, διαφημίσεις, προβολή γεωγραφικών 

περιοχών, εκπαιδευτικές ιστοσελίδες, ηλεκτρονικά Καταστήματα, ειδήσεις, χάρτες, 

οδηγίες, κλπ. Ένα CMS δημιουργείται και εγκαθίσταται από τους σχεδιαστές 

ιστοσελίδων, αλλά προορίζεται για χρήση από τελικούς χρήστες. Αρχικά, προσφέρει 

έναν εύκολο και εύχρηστο τρόπο ενημέρωσης περιεχομένου. Αυτό συνήθως γίνεται 

µε τη χρήση ενός συστήματος πλοήγησης (browser). Ο χρήστης απλά εισάγει το νέο 

κείμενο και το αποθηκεύει και η ιστοσελίδα μας εμφανίζεται αμέσως. Μπορούν πολύ 

εύκολα να προστεθούν νέες σελίδες, να διαγραφούν παλιές καθώς και να 

αναδιαμορφωθούν οι υπάρχουσες σύμφωνα με νέες απαιτήσεις και προδιαγραφές. 

Το περιεχόμενο που μπορεί να καλύψει το σύστημα διαχείρισης περιεχομένου είναι 

κείμενο, εικόνες, video και γενικά οτιδήποτε μπορεί να διανεμηθεί μέσω του 

διαδικτύου. 

Τα σημερινά ευρέως διαθέσιμα CMS υποστηρίζουν τέσσερεις βασικές λειτουργίες – 

δημιουργία περιεχομένου, διαχείριση περιεχομένου, δημοσίευση και παρουσίαση. 

Με αυτό τον τρόπο επιτυγχάνεται: 

 Μειωμένο κόστος συντήρησης  

 Γρήγορη ενημέρωση, διαχείριση και αρχειοθέτηση της πληροφορίας 

 Αυξημένη ευελιξία, βελτιωμένη πλοήγηση και αυξημένη δυνατότητα 

επέκτασης 

 Αυξημένη ασφάλεια 

 Δυνατότητα αλλαγής σχεδιασμού ή τρόπου πλοήγησης χωρίς να είναι 

απαραίτητη η ενημέρωση όλων των σελίδων από το χρήστη 
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 Όλο το περιεχόμενο είναι αποθηκευμένο στις βάσεις δεδομένων, τις οποίες 

μπορούμε να προστατεύσουμε τηρώντας αντίγραφα ασφαλείας. 

 Δεν απαιτούνται ιδιαίτερες τεχνικές γνώσεις από τους χρήστες. 

 Ενημέρωση του περιεχομένου από οπουδήποτε και από διαφορετικούς 

διαχειριστές περιεχομένου. 

 Το περιεχόμενο είναι καλά οργανωμένο και αναζητήσιμο. 

Σε σχέση με τις κατηγορίες CMS, αυτά διακρίνονται σε CMS κλειστού κώδικα και CMS 

ανοικτού κώδικα. Τα CMS κλειστού κώδικα έχουν εμπορική υποστήριξη και 

προσδιορισμένες υπηρεσίες. Μπορεί να είναι καλύτερα τεκμηριωμένα και πιο 

ασφαλή αλλά το βασικό τους μειονέκτημα είναι το κόστος. Εκτός από το βασικό 

κόστος υπάρχει το κόστος παραμετροποίησης και το κόστος ολοκλήρωσης. Μερικά 

από τα CMS κλειστού κώδικα είναι τα εξής: 

 IBM Workplace Web Content Management  

 Vignette Content Management  

 Powerfront CMS  

 Jalios JCMS  

 Dynamicweb CMS  

Τα πλεονεκτήματα τους περιλαμβάνουν αυξημένη ασφάλεια, καλύτερη εμπορική 

υποστήριξη, διαθεσιμότητα (είναι συνήθως ετοιμοπαράδοτα) και καλύτερη 

τεκμηρίωση και εκπαίδευση. Από τη άλλη πλευρά στα μειονεκτήματα τους 

καταγράφονται το βασικό κόστος αγοράς, το κόστος παραμετροποίησης και το 

κόστος ολοκλήρωσης με υπάρχοντα εταιρικά συστήματα. 

Τα CMS ανοιχτού κώδικα επιτρέπουν την πρόσβαση και αλλαγή του πηγαίου κώδικα. 

Το κόστος είναι πολύ μικρό καθώς στις περισσότερες περιπτώσεις η εφαρμογή 

βρίσκεται στο διαδίκτυο και ο χρήστης μπορεί να την κατεβάσει με μηδενικό κόστος. 

Συχνά συνοδεύεται από πρόσθετα (plug-ins) τα οποία δημιουργεί και προσφέρει η 

κοινότητα. Κάποια CMS ανοιχτού κώδικα είναι τα παρακάτω:  

 Wordpress  

 Drupal  

 Joomla  

 Moodle  

Τα πλεονεκτήματα CMS ανοιχτού κώδικα είναι το χαμηλό κόστος (αφού δεν 

απαιτείται αγορά λογισμικού), εύκολη παραμετροποίηση, εύκολη ολοκλήρωση με 

υπάρχοντα λογισμικά και η δυνατότητα της δοκιμής του προϊόντος πριν την χρήση 

του. Όσο αφορά την εκπαίδευση / υποστήριξη στη χρήση αυτών των συστημάτων, 

συνήθως αυτή προέρχεται από μια κοινότητα χρηστών και προγραμματιστών. 



Πτυχιακή : Ανάλυση συστημάτων διεπιχειρησιακής συνεργασίας στο διαδίκτυο 
 

 Σελίδα 26 
 

Στα μειονεκτήματα CMS ανοιχτού κώδικα περιλαμβάνονται η έλλειψη εμπορικής 

υποστήριξης και οι περιορισμένες δυνατότητες τους σε σχέση με τα CMS κλειστού 

κώδικα. Αυτό συνήθως τα καθιστά ακατάλληλα για επιχειρήσεις μεγάλου 

βεληνεκούς. 

4.3.1. Το CMS Joomla                                                          

Το όνομα "Joomla" είναι μια φωνητική γραφή της γλώσσας Σουαχίλι 

(Swahili) στην οποία η λέξη "jumla" σημαίνει "όλοι μαζί" ή "ως σύνολο".  Επέλεξαν 

αυτό το όνομα για να αντικατοπτρίζει τη δέσμευση της Κοινότητας και την ομάδα 

ανάπτυξης του έργου. Η πρώτη έκδοση του Joomla (Joomla 1.0.0) ανακοινώθηκε στις 

16 Σεπτεμβρίου 2005. Αυτή ήταν μια νέα ονομασία της έκδοσης Mambo 4.5.2.3 σε 

συνδυασμό με διορθώσεις κάποιον σφαλμάτων στο περιβάλλον διαχείρισης και στον 

κώδικα της ασφαλείας.  

Σήμερα, το Joomla είναι μια δωρεάν εφαρμογή ανοιχτού λογισμικού για τη 

δημιουργία δυναμικών ιστοσελίδων. Μπορεί να χρησιμοποιηθεί τόσο για 

προσωπικές όσο και επαγγελματικές ιστοσελίδες. Είναι γραμμένο σε γλώσσα PHP και 

τα δεδομένα αποθηκεύονται σε μια βάση δεδομένων MySQL. Το βασικό 

χαρακτηριστικό του είναι ότι οι σελίδες που εμφανίζει είναι δυναμικές. Το Joomla 

έχει πολλές δυνατότητες και ταυτόχρονα είναι εξαιρετικά ευέλικτο και φιλικό προς 

τον χρήστη. Είναι μία εφαρμογή με την οποία μπορεί κάποιος να δημοσιεύσει στο 

διαδίκτυο μια προσωπική ιστοσελίδα, αλλά και έναν ολόκληρο εταιρικό δικτυακό 

τόπο. Ο χρήστης έχει πρόσβαση στο περιβάλλον διαχείρισης μέσω ενός browser, 

όπως είναι ο Internet Explorer ή ο Firefox.  Οι δυνατότητες επέκτασής του είναι 

πρακτικά απεριόριστες. Από τη στιγμή που κάποιος είναι διαχειριστής, μπορεί να 

προσθέσει οποιοδήποτε κείμενο ή γραφικό, και έτσι να δημιουργήσει τις ιστοσελίδες 

του. Μπορεί να χρησιμοποιήσει το Joomla μόνος του και υπάρχουν διάφοροι τρόποι 

να ξεκινήσει. Μπορεί να κατεβάσει την τελευταία έκδοση του Joomla από το 

Joomlaforge ή αν θέλει, μπορεί να μάθει περισσότερα στον επίσημο ιστότοπο 

www.joomla.org (στα αγγλικά) ή στο ελληνικό site υποστήριξης, το joomla.gr. Από τη 

στιγμή που το εγκαταστήσει, μπορεί να αναζητήσει οδηγίες στο forum και στον 

ιστότοπο βοήθειας.  

Ενδεικτικό της δημοτικότητας του Joomla είναι το γεγονός ότι πολλοί σημαντικοί 

ιστότοποι έχουν επιλέξει το Joomla CMS για να διαχειρίζονται το περιεχόμενό τους. 

Μερικοί από τους γνωστότερους στην Ελλάδα είναι :  

 www.minedu.gov.gr  

  www.Gazzetta.gr  
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 www.geodata.gov.gr  

 www.singularlogic.gr  

 www.joomla.org 53  

 www.linux.com  

Το joomla CMS παρέχει πληθώρα δυνατοτήτων τόσο στους διαχειριστές με τρόπους 

διαχείρισης του ιστοτόπου όσο και στους χρήστες με τις επιλογές που προσφέρει. Ας 

αναφέρουμε τα κυριότερα :  

 Χρησιμοποιεί module και plug-in  

 Διαχείριση των Template  

 Δημοσίευση σελίδων και άρθρων χωρίς κανένα περιορισμό  

 Εύκολη διαχείριση online των jpeg, gif, png, pdf, doc, xls αρχείων μέσω του 

image library.  

 News feed Manager  

 Archieve manager  

 Ενσωματωμένος επεξεργαστής κειμένου  

 Banner manager για εισαγωγή διαφημίσεων  

 E-mail a friend, Print format και PDF view για κάθε άρθρο.  

 Δυνατότητα προεπισκόπησης των αλλαγών που κάνουμε στο site πριν  

 Δημοσιοποιηθούν 

Γενικά οι δυνατότητες χρήσης του Joomla περιορίζονται μόνον από τη 

δημιουργικότητα του χρήστη. Κάποιοι χρησιμοποιούν το Joomla για διασκέδαση, για 

τη κατασκευή μιας προσωπικής ή οικογενειακής ιστοσελίδας. Ενσωματώνοντας 

διάφορα, διαθέσιμα δωρεάν, πρόσθετα εργαλεία / επεκτάσεις, διευρύνονται οι 

δυνατότητες και λειτουργίες του Joomla, κάνοντάς το μια εφαρμογή αξιόπιστη για 

την ανάπτυξη σοβαρών εταιρικών δικτυακών τόπων.  

Η βασική δομή του Joomla περιλαμβάνει   

 Δημόσιο Τμήμα (Front End): Το δημόσιο Τμήμα είναι ουσιαστικά αυτό που 

βλέπει ο τελικός χρήστης. Στο δημόσιο τμήμα βρίσκονται τα άρθρα, τα μενού 

και γενικά όλα τα στοιχεία που θέλουμε να εμφανίζονται στην ιστοσελίδα. 

 Περιοχή διαχείρισης (Back End): Η περιοχή διαχείρισης είναι ο χώρος όπου 

εργάζεται ο διαχειριστής. Έχει τη δυνατότητα να προσθέτει περιεχόμενο, να 

δημιουργεί χρήστες, να τροποποιεί τα προϊόντα κτλ. 

 Μενού (Menus): Τα μενού δίνουν τη δυνατότητα στο χρήστη να πλοηγείται 

μέσα στην ιστοσελίδα. Μπορεί να έχουν οριζόντια ή κάθετη διάταξη, 

δημιουργούνται δυναμικά και συνδέονται με αντικείμενα του Joomla. 

Μπορούμε να έχουμε όσα μενού θέλουμε σε μια ιστοσελίδα Joomla. 
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 Εφαρμογές (Components): Οι εφαρμογές είναι απαραίτητες για την επέκταση 

του Joomla.Μπορεί να είναι εμπορικές ή ελεύθερης διανομής. Μερικά 

παραδείγματα είναι εφαρμογές για e-shop, gallery φωτογραφιών, e-learning. 

 Ενθέματα (Modules): Τα ενθέματα είναι τα ‘κουτιά’ που εμφανίζονται τα 

περιεχόμενα, οι εφαρμογές, τα πρόσθετα και γενικά όλα τα αντικείμενα που 

εμφανίζονται στο Δημόσιο Τμήμα. 

 Πρόσθετα (Plug-ins): Τα πρόσθετα είναι κομμάτια κώδικα τα οποία εκτελούν 

κάποιες ειδικές λειτουργίες. Για παράδειγμα, ένα πρόσθετο είναι η μηχανή 

αναζήτησης που έχει το Joomla για να μπορεί ο χρήστης να κάνει αναζήτηση 

περιεχομένου μέσα στη σελίδα. 

 Πρότυπα (Templates): Τα πρότυπα χρησιμοποιούνται για το διαχωρισμό του 

περιεχομένου από την εμφάνιση. Όλη η σχεδίαση της ιστοσελίδας βασίζεται 

στα πρότυπα αφού εκεί ορίζονται τα χρώματα, η θέση των ενθεμάτων κτλ. 

4.3.2. Σύγκριση Joomla με άλλα CMS 

Το Drupal, το Joomla και το WordPress  είναι τα τρία πιο δημοφιλή συστήματα 

διαχείρισης περιεχομένου (CMS). Και τα τρία είναι χτισμένα σε PHP και MySQL. Τα 

τρία αυτά CMS διαφέρουν σημαντικά όσον αφορά τις δυνατότητες, την ικανότητα, 

την ευελιξία και την ευκολία χρήσης. Παρακάτω θα αναφέρουμε μερικά από τα 

πλεονεκτήματα και τα μειονεκτήματα των τριών CMS. 

To Drupal είναι το παλαιότερο στη λίστα των συστημάτων CMS. Κυκλοφόρησε 

για πρώτη φορά στις αρχές του 2001.Οπως και το Joomla και το WordPress είναι open 

–source και βασίζεται στη γλώσσα php. Είναι πολύ εύκολο στην εγκατάσταση του και 

μπορεί να εκτελεστεί σε διάφορες πλατφόρμες. Το Drupal μπορεί να δημιουργήσει 

πολλούς διαφορετικούς τύπους ιστοσελίδων. Ο σχεδιασμός του δεν είναι τόσο 

ζωηρόχρωμος όπως στο Joomla αλλά μπορεί να προσαρμοστεί εύκολα. Σε αντίθεση 

με το Joomla δίνει τη δυνατότητα διαχείρισης πολλών ιστοτόπων με μια 

εγκατάσταση. Ένα πράγμα στο οποίο υστερεί σε σχέση με το Joomla είναι ότι δεν έχει 

υπολογισμό φόρων και επιλογές νομίσματος. Επίσης έχει  ένα πρότυπο για όλες τις 

σελίδες, αν και αυτό μπορεί να προσαρμοστεί. 

Το WordPress  αποτελεί κυρίαρχο της αγοράς λόγω της ευκολίας στη χρήση 

του. Απευθύνεται κυρίως σε αρχάριους στην κατασκευή ιστοσελίδων χωρίς 

ιδιαίτερες γνώσεις σε HTML,CSS,PHP και MySQL αλλά τους ενδιαφέρει μόνο η 

διαχείριση περιεχομένου. Αποτελεί κυρίαρχο της αγοράς λόγω της ευκολίας στη 

χρήση του. Ένα μειονέκτημα σε σχέση με τα άλλα CMS αφορά την ασφάλεια. Το ίδιο 

το λογισμικό δεν είναι πολύ ασφαλές και θα πρέπει να εγκατασταθούν plugins  για 

να ενισχυθεί η ασφάλεια εγκατάστασης του. Επίσης έχει περιορισμένες επιλογές 
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όσον αφορά το σχεδιασμό παρά το γεγονός ότι πρόσθετες βελτιώσεις –plugins έχουν 

διορθώσει κάπως αυτό το πρόβλημα. Σε περίπτωση λοιπόν που θέλουμε να 

δημιουργήσουμε κάτι πιο σύνθετο είναι προτιμότερο να χρησιμοποιήσουμε το 

Joomla. 

 

Σχήμα 5: Συχνότητα εμφάνισης των τριών Cms στις μηχανές αναζήτησης της Google. 

Συμπερασματικά, και τα τρία συστήματα διαχείρισης έχουν κάποια πλεονεκτήματα 

και μειονεκτήματα (βλέπε Σχήμα 5)  αλλά και τα τρία ποικίλουν σε χαρακτηριστικά 

και δυνατότητες. Είναι στη δική μας ευχέρεια να επιλέξουμε το CMS που ταιριάζει 

καλύτερα στις ανάγκες μας. 

4.4. HikaShop 

Το HikaShop είναι μια ανοιχτού κώδικα (Open Source) εφαρμογή για τη δημιουργία 

ηλεκτρονικών καταστημάτων. Λειτουργεί ως πρόσθετη εφαρμογή του δημοφιλούς 

συστήματος διαχείρισης (CMS) Joomla. Είναι γραμμένη σε γλώσσα PHP και 

αποθηκεύει τα δεδομένα του σε βάση δεδομένων MySQL. To HikaShop μας δίνει τη 

δυνατότητα διαχείρισης του περιεχομένου στο κατάστημα (κατηγορίες, προϊόντα 

κλπ), αποδοτικής διαχείρισης τιμών, και επίσης τη δυνατότητα εύκολα και γρήγορα 

να προσωποποιήσετε το e-shop μας σύμφωνα με τις ανάγκες σας μέσω ενός εύκολου 

περιβάλλοντος εργασίας. Μερικά από τα χαρακτηριστικά του HikaShop που το 

κατέστησαν χρήσιμο για τις ανάγκες της παρούσας πτυχιακής εργασίας είναι τα 

ακόλουθα: 

 Δημιουργία Προϊόντων 

 Δυνατότητα πολλαπλών εικόνων σε ένα προϊόν 

 Αρχείο προϊόντων 

 Σχετικά προϊόντα 

 Σύστημα σύγκρισης προϊόντων 

 Οι τιμές διατίθενται σε πολλά νομίσματα 
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 Δεν υπάρχει όριο στον αριθμό παραγγελιών 

 Ιστορικό παραγγελιών 

 E-mail επιβεβαίωσης παραγγελίας 

 Διαχείριση λογαριασμού από τους χρήστες 

 Γρήγορη αναζήτηση  

 Διαχείριση πολλών προϊόντων και κατηγοριών 

 Απ’ ευθείας υπολογισμών κόστους μεταφορών 

 Δυνατότητα πληρωμής με πιστωτική κάρτα 

4.5. Τεχνολογίες νέφους 

Οι τεχνολογίες νέφους (cloud computing) αναφέρονται σε ένα ανερχόμενο 

παράδειγμα που αλλάζει ριζικά τη διαχείριση υπολογιστικών πόρων στο διαδίκτυο. 

Η βασική φιλοσοφία είναι ότι αντί της καθιερωμένης διατήρηση πόρων και 

δεδομένων στο δικό μας σκληρό δίσκο, μπορούμε να χρησιμοποιήσουμε υπηρεσίες 

του Διαδικτύου, σε άλλη θέση, για να αποθηκεύουμε ή  να χρησιμοποιήσουμε 

εφαρμογές τρίτων. Το cloud computing λοιπόν, είναι ένα μοντέλο που μας δίνει τη 

δυνατότητα να χρησιμοποιούμε και να έχουμε πρόσβαση σε web εφαρμογές χωρίς 

να υπάρχουν στον υπολογιστή μας ή σε κάποια άλλη συσκευή που είναι συνδεδεμένη 

στο internet. Σε αυτό το μοντέλο η εφαρμογή είναι σε ένα server και εμείς τη 

χρησιμοποιούμε χωρίς την εγκατάσταση της στον υπολογιστή μας.  

Μερικά από τα πλεονεκτήματα των τεχνολογιών νέφους που έχουν καταστήσει την 

υποδομή αυτή ιδιαιτέρως δημοφιλή τα τελευταία χρόνια είναι: 

 Οικονομία, μιας και είναι εύκολο στη χρήση και δεν απαιτεί πολλές 

εγκαταστάσεις. 

 Εύκολη εγκατάσταση και παραμετροποίηση. 

 Πρόσβαση από οποιαδήποτε συσκευή διαθέτει σύνδεση στο internet. 

 Μεγάλος αποθηκευτικός χώρος. Με το cloud computing έχουμε συνήθως όσο 

χώρο χρειαζόμαστε. 

Από την άλλη πλευρά εξακολουθούν και υφίστανται κίνδυνοι που αφορούν κυρίως: 

 Ασφάλεια δεδομένων. Είναι λογικό κάποιες φορές να έχουμε συγκεκριμένα 

δεδομένα σε δικό μας τοπικό server και όχι στο cloud. 

 Αυξημένη πολυπλοκότητα. Αυτό συμβαίνει όταν έχουμε 

μία εφαρμογή αποθηκευμένη κάπου τοπικά, σε ένα δικό μας web server και 

προσπαθούμε να την κάνουμε να επικοινωνήσει με μία άλλη στο cloud. Τα 

πράγματα εκεί γίνονται αρκετά περίπλοκα και πολλές φορές η λύση εκτός ότι 

δεν είναι προφανής , αποτυγχάνει.  
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Στα πλαίσια της παρούσας εργασίας έγινε προσπάθεια εξοικείωσης και 

ενσωμάτωσης υπηρεσιών νέφους. Για το σκοπό αυτό αξιοποιήθηκαν ευρέως 

διαδεδομένες υπηρεσίες της Google οι οποίες συνοψίζονται ακολούθως. 

4.5.1. Google Drive 

To Google drive προσφέρει δυνατότητες αποθήκευσης όλων των αρχείων μας σε 

πόρους του νέφους γεγονός που επιτρέπει πρόσβαση σε αυτά από οπουδήποτε και 

από οποιαδήποτε συσκευή. Η πρόσβαση των χρηστών στα αρχεία τους γίνεται μέσω 

της σελίδας  drive.google.com ή διαφορετικά κατεβάζοντας την εφαρμογή. Η 

εφαρμογή συγχρονίζει το περιεχόμενο σε όλες τις συσκευές ώστε να έχουμε πάντα 

την τελευταία έκδοση των αρχείων μας. Τα αρχεία που μοιράζονται δημόσια στο 

Google Drive μπορούν να αναζητηθούν με μηχανές αναζήτησης. Ως προς τη 

διαχείριση αρχείων λοιπόν το Google Drive προφέρει τα ακόλουθα πλεονεκτήματα: 

 επιτρέπει αποθήκευση και διαμοιρασμό αρχείων ή / και ολόκληρων φακέλων 

με μεμονωμένα άτομα ή με μια ομάδα ατόμων 

 δημιουργία σχολίων και ανταπόκριση σε σχόλια άλλων για οποιοδήποτε 

αρχείο 

 είναι μέρος των Google Apps και αυτό επιτρέπει συνεργασία με συνεργάτες 

σε πραγματικό χρόνο σε έγγραφα, υπολογιστικά φύλλα και παρουσιάσεις 

 υποστηρίζει πρόσβαση σε πάνω από 30 τύπους αρχείων στο δίσκο (βίντεο, 

εικόνες, αρχεία Adobe και Photoshop, και πολλά άλλα) χωρίς εγκατάσταση 

πρόσθετου λογισμικού 

 προσφέρει δια λειτουργικότητα με browsers 

4.5.2. Google Analytics  

Μια δεύτερη κατηγορία υπηρεσίας που αξιοποιήθηκε στην παρούσα εργασία είναι η 

Google Analytics. Η υπηρεσία παρέχεται δωρεάν και προσφέρει αναλυτικές 

πληροφορίες σχετικά με την επισκεψιμότητα μίας ιστοσελίδας. Ενδεικτικά, μέσω της 

συγκεκριμένης υπηρεσίας μπορούμε να εξετάσουμε το πώς οι επισκέπτες έφτασαν 

σε μια ιστοσελίδα, τι χρόνο διέθεσαν σε ποιες εσωτερικές σελίδες, καθώς και πολλές 

ακόμη πληροφορίες που μπορούν να βοηθήσουν κατά την βελτιστοποίηση ενός site.  

Η λειτουργία της υπηρεσίας είναι απλή. Ο κάθε εγγεγραμμένος χρήστης μπορεί να 

προσθέσει για ανάλυση και παρακολούθηση όσες ιστοσελίδες επιθυμεί. Για κάθε ένα 

από τα websites, το Google Analytics παρέχει έναν μοναδικό κώδικα (Google Analytics 

Tracking Code) ο οποίος πρέπει να ενσωματωθεί σε όλες τις σελίδες του site, 

συνήθως στο <head> ή στο τέλος του <body> της σελίδας. Με τον συγκεκριμένο 

κώδικα εγκατεστημένο, κάθε φορά που ένας χρήστης επισκέπτεται το site, 

συλλέγονται στατιστικά στοιχεία γι΄αυτό, όπως είναι για παράδειγμα ο χρόνος 

παραμονής στις εσωτερικές σελίδες ή οι σύνδεσμοι τους οποίους ο χρήστης 
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ακολούθησε για να καταλήξει στο site. Αυτά τα στοιχεία αποστέλλονται άμεσα στην 

υπηρεσία της Google, αναλύονται, κατανέμονται στις σωστές κατηγορίες και 

παρουσιάζονται σε έναν εύχρηστο περιβάλλον. 

Τα οφέλη από την χρήση της συγκεκριμένης υπηρεσίας είναι αρκετά. Παρέχει μια 

πλήρη εικόνα σχετικά με την επισκεψιμότητα στην ιστοσελίδα σας, δημογραφικά 

στοιχεία που αφορούν στους επισκέπτες της, όπως είναι για παράδειγμα η περιοχή 

διαμονής τους και η μητρική τους γλώσσα, στατιστικά στοιχεία σχετικά με το ποσοστό 

επιστροφής στην σελίδα και τον χρόνο πλοήγησης σε αυτήν, πληροφορίες για τον 

browser με τον οποίο την επισκέφθηκαν, καθώς και τους τρόπους με τους οποίους 

κατέληξαν σε αυτήν (keywords, referral links κλπ). Κατανοώντας επομένως αυτά τα 

στατιστικά και αξιοποιώντας τα, μπορείτε να βελτιστοποιήσετε το περιεχόμενο στις 

σελίδες σας. 

Τέλος, θα πρέπει να αναφερθεί ότι μέσω του Google Analytics, δίνεται η δυνατότητα 

να προστεθούν στόχοι και ειδοποιήσεις αλλά και να επιτυγχάνεται η αναλυτική 

παρακολούθηση στοιχείων των πωλήσεων που γίνονται σε ένα site και από ποια 

καμπάνια ήρθαν οι πελάτες. Έτσι, μπορεί να γίνει και η αξιολόγηση σε πραγματικά 

ποσά της απόδοσης ενός διαφημιστικού προϋπολογισμού. 

4.5.3. Google Maps 

Η τελευταία υπηρεσία νέφους που αξιοποιήθηκε από την παρούσα εργασία είναι η 

υπηρεσία Google Maps. Πρόκειται για μια υπηρεσία χαρτογράφησης στο Διαδίκτυο. 

Η τεχνολογία παρέχεται από την Google και υποστηρίζει πολλές υπηρεσίες που 

βασίζονται σε χάρτες, συμπεριλαμβανομένου της ιστοσελίδας "Χάρτες Google". 

Προσφέρει χάρτες δρόμων και σχεδιαστή διαδρομών για μεταφορές με τα πόδια, 

αυτοκίνητο, ποδήλατο (beta) ή μέσα μαζικής μεταφοράς. Περιλαμβάνει επίσης 

εντοπισμό των επιχειρήσεων που βρίσκονται σε πόλεις σε πολλές χώρες σε όλο τον 

κόσμο. Οι δορυφορικές εικόνες των Χαρτών Google δεν ανανεώνονται σε πραγματικό 

χρόνο, ωστόσο η Google προσθέτει δεδομένα στη Κύρια Βάση δεδομένων της σε 

τακτική βάση και οι περισσότερες από τις εικόνες δεν είναι πάνω από τριών ετών. 

 

 

  



Πτυχιακή : Ανάλυση συστημάτων διεπιχειρησιακής συνεργασίας στο διαδίκτυο 
 

 Σελίδα 33 
 

5. Περίπτωση χρήσης: Ηλεκτρονικό κατάστημα 

βιολογικών προϊόντων 
 

5.1. Επισκόπηση πεδίου εφαρμογής  

Τα τελευταία χρόνια τα βιολογικά προϊόντα εμφανίζονται ολοένα και περισσότερο 

στα ράφια των σούπερ μάρκετ. Με τον όρο βιολογική καλλιέργεια εννοούμε τη 

φιλική προς το περιβάλλον γεωργία η οποία δεν χρησιμοποιεί χημικά φυτοφάρμακα 

και λιπάσματα. Βασίζεται στην ανακύκλωση των φυτικών υπολειμμάτων και τους 

βιολογικούς τρόπους αντιμετώπισης των εχθρών των φυτών. Η βιολογική 

καλλιέργεια δεν είναι απλά ένας διαφορετικός τρόπος καλλιέργεια αλλά μια 

διαφορετική φιλοσοφία παραγωγής που έχει βασικό στόχο το σεβασμό στη φύση. 

Προϊόντα βιολογικής καλλιέργειας είναι τα προϊόντα που κατά την παραγωγή τους 

έχουν εφαρμοστεί κανόνες που καθορίζονται από την εθνική νομοθεσία με σκοπό 

την προστασία του περιβάλλοντος. Τα βιολογικά προϊόντα εγγυώνται αυθεντικές 

γεύσεις και ποιότητα ζωής και αποτελούν την απάντηση στα μεταλλαγμένα προϊόντα 

που κυκλοφορούν στην αγορά. Στην Ευρώπη η βιολογική καλλιέργεια αυξάνεται με 

μεγάλους ρυθμούς ενώ έχει να αναπτύσσεται αρκετά και στη χώρα μας. Τη σημερινή 

εποχή όλο και περισσότεροι καταναλωτές στρέφονται στα βιολογικά προϊόντα. 

Για να αναγνωρίσουμε αν ένα προϊόν είναι βιολογικό θα πρέπει να υπάρχουν οι 

παρακάτω ενδείξεις: 

 To εθνικό σήμα αναγνώρισης πιστοποιημένων προϊόντων βιολογικής 

καλλιέργειας. 

 Η ένδειξη «Προϊόν βιολογικής καλλιέργειας» σε συνδυασμό με την ονομασία 

πώλησης του προϊόντος. 

 Το λογότυπο του. 

 Ο κωδικός αριθμός έγκρισης του από τον Οργανισμό Ελέγχου & 

Πιστοποίησης. 

5.2. Στόχοι τεχνική προσέγγιση 

Με αναφορά στο πεδίο των βιολογικών προϊόντων, η παρούσα πτυχιακή στόχευσε 

στην ενσωμάτωση βασικών τεχνολογιών (που εξετάστηκαν στο προηγούμενο 

κεφάλαιο) για την ανάπτυξη ενός ηλεκτρονικού καταστήματος προώθησης 

βιολογικών προϊόντων. Για το σκοπό αυτό επιλέχθηκαν συγκεκριμένα εργαλεία τα 

οποία είτε τροποποιήθηκαν είτε επεκτάθηκαν είτε ενσωματώθηκαν προκειμένου να 

επιτευχθεί η επιθυμητή λειτουργικότητα. 



Πτυχιακή : Ανάλυση συστημάτων διεπιχειρησιακής συνεργασίας στο διαδίκτυο 
 

 Σελίδα 34 
 

5.3. Ανάπτυξη ηλεκτρονικού καταστήματος με το Joomla 

Για την ανάπτυξη του ηλεκτρονικού καταστήματος επιλέχθηκε το CMS Joomla. Στα 

τμήματα που ακολουθούν περιγράφονται οι βασικές λειτουργίες που αξιοποιήθηκαν 

και ο τρόπος που ενσωματώθηκαν στο τελικό πρωτότυπο. 

5.3.1. Επιλογή template 

Το πρώτο βήμα για την κατασκευή μιας ιστοσελίδας είναι η επιλογή του κατάλληλου 

template το οποίο θα πρέπει να είναι φιλικό προς το χρήστη και να ικανοποιεί τις 

ανάγκες του. Για αυτό το λόγο επιλέχτηκε το template 

tmpl_prismatic_for_joomla3_1.3. Το Joomla μας δίνει τη δυνατότητα να 

χρησιμοποιήσουμε κάποιο έτοιμο πρότυπο από αυτά που διαθέτει (βλέπε Σχήμα 6). 

Για την προβολή των έτοιμων προτύπων πηγαίνουμε στο Extensions->Template 

Manager. Για να εγκαταστήσουμε το πρότυπο που επιλέξαμε εμείς πηγαίνουμε στην 

καρτέλα Extensions->Extension Manager  και κάνουμε Install το αρχείο (βλέπε Σχήμα 

6).  

 

Σχήμα 6: Αναζήτηση του αρχείου 

 Στη συνέχεια πηγαίνοντας στην καρτέλα Extensions->Template Manager και 

ορίζοντας το template μας Default το ενεργοποιούμε. Το δεύτερο πρότυπο(isis) το 

οποίο είναι ορισμένο ως Default είναι το πρότυπο το οποίο χρησιμοποιείται στην 

περιοχή διαχείρισης. 

 

Σχήμα 7: Ορισμός του template ως προεπιλεγμένο 

Για να πραγματοποιήσουμε αλλαγές στο template μας θα γίνει η κατάλληλη 

παραμετροποίηση των αρχείων CSS του template prismatic. Για να βρούμε το αρχείο 

CSS θα πάμε από την καρτέλα Extensions->Template Manager και θα βρούμε το 
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template μας. Πατώντας πάνω μας βγάζει όλους τους φακέλους που 

συμπεριλαμβάνονται στο πρότυπο μας και ανάμεσα σε αυτούς και τον φάκελο CSS. 

 

Σχήμα 8: Αρχείο CSS του template 

Επιλέγοντας το μας βγάζει όλο τον κώδικα που είναι γραμμένος για τη μορφοποίηση 

του προτύπου και από εκεί θα κάνουμε όλες τις απαραίτητες αλλαγές (βλέπε Error! 

Reference source not found.). 

 

Σχήμα 9: Κώδικας CSS 

 

5.3.2. Δημιουργία κατηγορίας 

Για την ευκολότερη διαχείριση των άρθρων, το Joomla μας δίνει τη δυνατότητα 

δημιουργίας κατηγοριών. Με τη δημιουργία κατηγοριών ο διαχειριστής μπορεί να 
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κατηγοριοποιεί τα άρθρα του και με αυτό τον τρόπο να μπορεί να τα διαχειριστεί πιο 

εύκολα. Κάνοντας τροποποίηση μιας κατηγορίας οι αλλαγές θα επηρεάσουν όλα τα 

άρθρα που ανήκουν σε αυτή τη κατηγορία. 

Η δημιουργία μια κατηγορίας (βλέπε Σχήμα 10)  γίνεται από την καρτέλα Content ->  

Category Manager->Add New Category και κάνουμε κλικ στο κουμπί New. 

 Στο πλαίσιο κειμένου Title εισάγουμε τον τίτλο που θα δώσουμε στην 

κατηγορία. Ο τίτλος αυτός θα εμφανίζεται στην Εμφάνιση Ιστοσελίδας (Front 

End).Στην περίπτωση μας θα εισάγουμε «Bioshop». 

 Στη λίστα Parent επιλέγουμε την γονική κατηγορία που θα εντάξουμε την 

κατηγορία μας. Εμείς επιλέγουμε No Parent γιατί δεν θέλουμε η νέα μας 

κατηγορία να ανήκει σε κάποια άλλη. 

 Στη λίστα Status επιλέγουμε την κατάσταση της κατηγορίας. Εμείς αφήνουμε 

την επιλογή Published. 

 Στη λίστα Access δηλώνουμε ποιοι θα βλέπουν την κατηγορία. Επιλέγουμε 

Public γιατί θέλουμε να τη βλέπουν όλοι. 

 Στη λίστα Language επιλέγουμε τη γλώσσα για την οποία θα είναι διαθέσιμη 

η κατηγορία. 

 Στην επιλογή Description γράφουμε κάποιο κείμενο το οποίο θέλουμε να 

συνοδεύει την κατηγορία. 

 

Σχήμα 10:  Δημιουργία κατηγορίας 

Αφού ολοκληρώσουμε τις ρυθμίσεις πατάμε Save&Close και αποθηκεύουμε την 

κατηγορία. 
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5.3.3. Δημιουργία άρθρου 

Τα άρθρα αποτελούν σημαντικό κομμάτι ενός ιστότοπου που βασίζεται σε σύστημα 

διαχείρισης περιεχομένου. Τα άρθρα περιέχουν το μεγαλύτερο κομμάτι του 

περιεχομένου που εμφανίζεται στην πλειονότητα των ιστοτόπων. Η δημιουργία ενός 

νέου άρθρου γίνεται από την καρτέλα Content->Article Manager->Add New Article 

(βλέπε Σχήμα 11). 

 Στο πλαίσιο κειμένου Title εισάγουμε τον τίτλο που θα έχει το άρθρο μας. Ο 

Τίτλος του άρθρου θα εμφανίζεται στο Front End .Εμείς εισάγουμε τον τίτλο 

«Bio shop». 

 Στη λίστα Category επιλέγουμε σε ποια κατηγορία θα ανήκει το άρθρο που 

δημιουργούμε. Επιλέγουμε την κατηγορία” Bioshop” . 

 Στην περιοχή Content εισάγουμε το κείμενο που θέλουμε να εμφανιστεί. 

 Τις υπόλοιπες ρυθμίσεις τις αφήνουμε όπως είναι. 

 

 

Σχήμα 11: Δημιουργία Άρθρου 

Αφού ολοκληρώσουμε τις ρυθμίσεις πατάμε Save&Close και αποθηκεύουμε το 

άρθρο. 

5.3.4. Δημιουργία Στοιχείων Menu 

 Τα Menu είναι πολύ σημαντικά γιατί βοηθούν το χρήστη στην πλοήγηση μέσα στην 

ιστοσελίδα. Μπορούμε να έχουμε όσα menu θέλουμε και να τα τοποθετούμε μέσα 

στη σελίδα όπως θέλουμε. Για να δημιουργηθεί ένα menu θα πρέπει να ορίσουμε τα 
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στοιχεία του, δηλαδή τους συνδέσμους που κάνοντας κλικ πάνω τους θα μας 

οδηγούν στις επιθυμητές σελίδες. Η δημιουργία ενός menu (βλέπε Σχήμα 12) γίνεται 

από την καρτέλα Menu->Main Menu->Add New Menu Item. 

 Στο πλαίσιο κειμένου Title εισάγουμε το όνομα που θέλουμε να έχει το menu 

μας. Εμείς χρησιμοποιούμε το όνομα Αρχική, ακριβώς όπως ονομάζεται το 

άρθρο και η κατηγορία μας. 

 Στο πλαίσιο Menu Item Type επιλέγουμε Select->Articles->Category Blog. 

 Τις υπόλοιπες ρυθμίσεις τις αφήνουμε όπως είναι. 

 

Σχήμα 12:  Δημιουργία Menu Item 

Αφού ολοκληρώσουμε τις ρυθμίσεις πατάμε Save&Close και αποθηκεύουμε το 

menu. Το άρθρο στη συνέχεια εμφανίζεται στη κεντρική σελίδα (βλέπε Σχήμα 13). 

 

Σχήμα 13: Εμφάνιση άρθρου στη σελίδα 

Με τον ίδιο τρόπο δημιουργήθηκαν τα υπόλοιπα άρθρα (βλέπε Σχήμα 14) και 

κατηγορίες (βλέπε Σχήμα 15) που χρησιμοποιήθηκαν στην παρούσα πτυχιακή.  
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Σχήμα 14: Λίστα άρθρων που δημιουργήσαμε 

 

Σχήμα 15: Λίστα όλων των κατηγοριών που δημιουργήσαμε 

5.3.5. Δημιουργία Φόρμας Επικοινωνίας 

Για τη δημιουργία της Contact Form (βλέπε Σχήμα 16) θα πάμε στην καρτέλα 

Components->Contacts και θα πατήσουμε New. Εισάγουμε τα στοιχεία της εταιρίας 

μας όπως φαίνεται παρακάτω και πατάμε Save&Close. 
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Σχήμα 16: Στοιχεία της Contact Form 

Στη συνέχεια πηγαίνουμε στην καρτέλα Menus->Menu Manager->Add New Menu και 

συμπληρώνουμε τα πεδία Title και Menu type. 

 

 

Σχήμα 17: Δημιουργία Menu Item 

Για να εμφανιστεί η Contact Form στην ιστοσελίδα μας θα πάμε να φτιάξουμε ένα 

νέο Menu Item. Πηγαίνουμε στην καρτέλα Main Menu->Add New Menu Item και 

εμφανίζεται η σελίδα στο Σχήμα 17. Στο πεδίο Title εισάγουμε το όνομα του Menu το 

οποίο θα είναι «Επικοινωνία». Στο πεδίο Menu Item Type επιλέγουμε Single Contact. 

Στο πεδίο Select Contact επιλέγουμε Επικοινωνία. Τέλος, πατάμε Save&Close (βλέπε 

Σχήμα 18 - Σχήμα 19. 
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Σχήμα 18: Δημιουργία Menu Item Επικοινωνία 

 

Σχήμα 19: Εμφάνιση στη σελίδα μας 

5.3.6. Επέκταση Λειτουργικότητας Joomla 

Το Joomla μας παρέχει τη δυνατότητα ενσωμάτωσης επιπλέον λειτουργικότητας. Η 

λειτουργικότητα αυτή αναφέρεται  στις επεκτάσεις (extensions).Ο όρος επεκτάσεις 

αναφέρεται στις εφαρμογές(components), ενθέματα(modules), πρόσθετα(plug-ins), 

πρότυπα (templates), και γλώσσες (languages). Υπάρχουν πολλές επεκτάσεις 
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διαθέσιμες για το Joomla είτε εμπορικά διαθέσιμες, είτε δωρεάν. Πολλές από αυτές 

τις επεκτάσεις μπορούμε να τις βρούμε στη σελίδα extensions.joomla.org.  

Η εγκατάσταση των επεκτάσεων γίνεται με τον εξής τρόπο. Πηγαίνουμε στην επιλογή 

Extensions ->Extension Manager στην πρώτη καρτέλα Install.Κάνουμε αναζήτηση το 

αρχείο το οποίο θα πρέπει να είναι σε μορφή zip και αφού το εντοπίσουμε κάνουμε 

κλικ στο Upload&Install.Αφού γίνει η εγκατάσταση μας βγάζει μήνυμα ότι το αρχείο 

εγκαταστάθηκε επιτυχώς. 

 

Σχήμα 20: Εγκατάσταση Επεκτάσεων 

5.3.7. Διαχείριση Ενθεμάτων 

Επιλέγουμε Extensions-> Module Manager για να ανοίξουμε το Module Manager 

(διαχείριση ενθεμάτων). Σε αυτή την οθόνη που εμφανίζεται σε μορφή πίνακα, τα 

ενθέματα  εμφανίζονται μαζί με ορισμένες κοινές επιλογές για τον τρόπο 

παρουσίασης τους. Εάν επιλέξουμε ένα ένθεμα για επεξεργασία(edit), θα εμφανιστεί 

η οθόνη με τις επιλογές και ρυθμίσεις του ενθέματος.  

Βασικές πληροφορίες ενθέματος: 

 Title (o τίτλος που θέλουμε να έχει το ένθεμα μας) 

 Show Title(επιλέγουμε αν θέλουμε να εμφανίζεται ο τίτλος του ενθέματος ) 

 Position(επιλέγουμε τη θέση που θα εμφανίζεται στον ιστότοπο μας 

σύμφωνα με το πρότυπο που έχουμε επιλέξει) 

 Status(μας δείχνει αν είναι δημοσιευμένο)  

 Start Publishing(αναφέρεται στην ημερομηνία έναρξης δημοσίευσης) 

 Ordering(επιλέγουμε τη  σειρά τοποθέτησης του, εάν υπάρχουν κι άλλα 

ενθέματα στην ίδια θέση ) 

 Language(η γλώσσα με την οποία θα εμφανίζεται) 

Οι παραπάνω λεπτομέρειες είναι εύκολα κατανοητές. Η μόνη που χρειάζεται 

περεταίρω επεξήγηση είναι η Access. Αυτή η ρύθμιση καθορίζει ποιες ομάδες 

χρηστών (βάσει δικαιωμάτων) θα μπορούν να βλέπουν περιεχόμενο από αυτό το 

ένθεμα σε μια σελίδα.  



Πτυχιακή : Ανάλυση συστημάτων διεπιχειρησιακής συνεργασίας στο διαδίκτυο 
 

 Σελίδα 43 
 

Οι επιλογές στην περιοχή Menu Assignment, μας επιτρέπει να διασυνδέουμε ένα 

ένθεμα με στοιχεία μενού. Η διασύνδεση ενός ενθέματος με στοιχεία μενού ελέγχει 

σε ποιες σελίδες θα εμφανίζεται το ένθεμα. Μπορούμε να επιλέξουμε να 

εμφανίζεται σε όλες τις σελίδες, σε καμία σελίδα ή μόνο στις σελίδες που επιλέγουμε 

εμείς. 

5.3.8. Εγκατάσταση του extension Slider 

Θα κάνουμε εγκατάσταση του ενθέματος mod_reslider_2.0.5 το οποίο το βρήκαμε τη 

σελίδα extensions.joomla.org. Όπως αναφέραμε πιο πάνω θα πάμε στη σελίδα 

Extensions->Extension Manager για να αναζητήσουμε το αρχείο και να το 

εγκαταστήσουμε.   

 

Σχήμα 21: Εγκατάσταση Slider 

Αφού εγκαταστήσαμε το αρχείο θα πάμε στον πίνακα διαχείρισης για να το 

επεξεργαστούμε. Πηγαίνουμε λοιπόν στην επιλογή Extensions->Extension Manager 

και αφού το βρούμε επιλέγουμε Edit και εμφανίζεται η παρακάτω σελίδα. 

 

Σχήμα 22: Ρυθμίσεις Slider 
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Αφήνουμε τον τίτλο όπως είναι ή δίνουμε ένα δικό μας όνομα. Στην επιλογή Show 

Title επιλέγουμε Hide ώστε να μην εμφανίζεται ο τίτλος στην ιστοσελίδα μας. Στην 

επιλογή Position επιλέγουμε τη θέση slider όπως ορίζει το πρότυπο μας. Στη συνέχεια 

πηγαίνουμε στη σελίδα Menu Assignment και επιλέγουμε τις σελίδες στις οποίες 

θέλουμε να εμφανίζεται το Slider. 

 

Σχήμα 23: Επιλογή σελίδων εμφάνισης 

Στην καρτέλα Images θα προσθέσουμε τις φωτογραφίες που θα εμφανίζονται. 

 

Σχήμα 24: Εισαγωγή εικόνων στο Slider 
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Σχήμα 25: Εμφάνιση Slider 

5.3.9. Εισαγωγή εργαλείου Αναζήτησης 

Το εργαλείο αναζήτησης υπάρχει ήδη στη περιοχή διαχείρισης και το μόνο που 

πρέπει να κάνουμε είναι να το ενεργοποιήσουμε. Πηγαίνουμε στην καρτέλα 

Extensions->Module Manager,βρίσκουμε το Search και πατώντας Edit μας βγάζει την 

παρακάτω σελίδα στην οποία ορίζουμε τη θέση του ενθέματος και το κάνουμε 

Published ώστε να εμφανίζεται στην ιστοσελίδα μας. Στην καρτέλα Menu Assignment 

επιλέγουμε τις σελίδες στις οποίες θέλουμε να εμφανίζεται. 

 

Σχήμα 26: Ρυθμίσεις εργαλείου Αναζήτησης 
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Σχήμα 27: Αναζήτηση προϊόντος 

5.3.10. Προσθήκη Ημερολογίου  

Το ημερολόγιο όπως είναι βασικό εργαλείο ενημέρωσης των χρηστών σε όλες τις 

ιστοσελίδες για αυτό και δε θα μπορούσαμε να το παραλείψουμε και στη δική μας.  

Επιλέγουμε το εργαλείο  mod_minicalendar_3.06 και το εγκαθιστούμε με τον τρόπο 

που δείξαμε παραπάνω.  

 

Σχήμα 28: Ρυθμίσεις Ημερολογίου 
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Επιλέγουμε τον τίτλο του ενθέματος και επιλέγουμε Hide ώστε να μην εμφανίζεται 

στην ιστοσελίδα μας. Κάνουμε το Status Public και ορίζουμε τη θέση εμφάνισης του. 

Στην καρτέλα Menu Assignment επιλέγουμε τις σελίδες στις οποίες θέλουμε να 

εμφανίζεται. 

5.3.11.  Ένθεμα πρόγνωσης καιρού 

Το ένθεμα πρόγνωσης καιρού είναι ένα ακόμα χρήσιμο εργαλείο για να κάνει τη 

σελίδα μας ποιο ελκυστική προς τους επισκέπτες της. Επιλέξαμε το αρχείο  

mod_kweather_12 και το εγκαταστήσαμε με το γνωστό τρόπο. 

 

Σχήμα 29: Ρυθμίσεις εν θέματος πρόγνωσης καιρού 

Στο Mode επιλέγουμε Specific Location. Στο City Name επιλέγουμε Greece. Στο 

Translated City Name το όνομα της πόλης που θα εμφανίζεται. 

5.3.12. Εισαγωγή καλαθιού αγορών 

Το καλάθι αγορών προσφέρεται από το HikaShop και μπορούμε να το βρούμε και 

αυτό στο Extensions->Module Manager. 

 

Σχήμα 30: Ρυθμίσεις καλαθιού αγορών 



Πτυχιακή : Ανάλυση συστημάτων διεπιχειρησιακής συνεργασίας στο διαδίκτυο 
 

 Σελίδα 48 
 

Στο Title ορίζουμε σαν όνομα <<Καλάθι Αγορών>>. Έπειτα επιλέγουμε να φαίνεται ο 

τίτλος του, καθώς και τη θέση του. Τέλος, κάνουμε το ένθεμα Published. 

Παρατηρούμε ότι στην ίδια σελίδα μας βγάζει και την επιλογή HikaShop 

options.Πατώντας το μας βγάζει επιπλέον ρυθμίσεις που ορίζονται από το HikaShop. 

 

Σχήμα 31: Ρυθμίσεις καλαθιού στον κατάλογο του Hikashop 

 

Σχήμα 32: Εμφάνιση ενθεμάτων 

5.3.13. Ρυθμίσεις Πληρωμών 

Πηγαίνοντας στην καρτέλα Components->HikaShop είμαστε στην περιοχή 

διαχείρισης του HikaShop.Στην καρτέλα System->Payment Methods μπορούμε να 
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ορίσουμε τους τρόπους πληρωμής. Πατώντας New μας εμφανίσει όλες τις επιλογές.

 

Σχήμα 33: Καρτέλα Payment methods 

Επιλέγουμε το HikaShop bank transfer payment plug-in και εμφανίζεται η παρακάτω 

σελίδα στην οποία θα κάνουμε τις απαραίτητες ρυθμίσεις. 

 Στο Name εισάγουμε το όνομα  Bank transfer 

 Στο πεδίο Description γράφουμε αν θέλουμε μια περιγραφή 

 Στις ρυθμίσεις General configuration στην επιλογή Images βάζουμε μια 

εικόνα και στην επιλογή price βάζουμε την τιμή χρέωσης . 

Τέλος πατάμε Save&Close. 

 

Σχήμα 34: Ορισμός πληρωμής μέσω τράπεζας 

Στη συνέχεια θα προσθέσουμε άλλον ένα τρόπο αποστολής ο οποίος θα είναι η 

Αντικαταβολή. Πατάμε New και επιλέγουμε το HikaShop collect on delivery payment 

plug in. Κάνουμε τις απαραίτητες ρυθμίσεις όπως και παραπάνω και πατάμε 

Save&Close. 
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Σχήμα 35: Ορισμός τρόπου πληρωμής με αντικαταβολή 

5.3.14. Ρυθμίσεις Αποστολής 

Για να ρυθμίσουμε τους τρόπους αποστολής πηγαίνουμε στο Systems->Shipping 

Methods και πατάμε New.Επιλέγουμε το HikaShop Australia Post shipping plug in και 

θα πάμε να το επεξεργαστούμε. 

 Στο πεδίο Name γράφουμε ΕΛΤΑ 

 Στο Description θα βάλουμε μια σχετική φωτογραφία 

 Στο Specific configuration μας εμφανίζει τους τρόπους αποστολής οι οποίοι 

είναι Express,Standard,Air,Sea.Εμείς θα τους επιλέξουμε όλους. 

Τέλος πατάμε Save&Close και αποθηκεύονται οι ρυθμίσεις μας. 

 

Σχήμα 36: Ορισμός τρόπου αποστολής ΕΛΤΑ 

5.3.15. Δημιουργία Προμηθευτών των προϊόντων 

Σε αυτό το σημείο θα προσθέσουμε όλους τους προμηθευτές που θα ανήκουν τα 

προϊόντα μας. Αυτό γίνεται πηγαίνοντας από το μενού του Hikashop στο Products-
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>Brands->New. Στο Name βάζουμε το όνομα του Προμηθευτή και στο Image βάζουμε 

εικόνα. Στη συνέχεια πατάμε Save&Close για να αποθηκευτεί. 

 

Σχήμα 37: Δημιουργία προμηθευτή 

Με τον ίδιο τρόπο δημιουργούμε και τους υπόλοιπους προμηθευτές. 

 

Σχήμα 38: Όλοι οι προμηθευτές 

Για να ορίσουμε τη θέση και για τις απαραίτητες ρυθμίσεις πηγαίνουμε στο 

Extensions->Module Manager, βρίσκουμε το Module Brands και το ανοίγουμε. 

 Αλλάζουμε τον τίτλο από Brands σε Προμηθευτές. 

 Κάνουμε το Status Published. 

 Τέλος πηγαίνουμε στο Menu Assignment για να ορίσουμε σε ποιές σελίδες θα 

εμφανίζεται. 
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Σχήμα 39: Ρυθμίσεις εμφάνισης προμηθευτών 

 

Σχήμα 40: Εμφάνιση προμηθευτών στην ιστοσελίδα μας 

5.3.16. Δημιουργία Κατηγορίας στο HikaShop 

Για την ευκολία της διαχείρισης των προϊόντων από εμάς, καθώς και από τον 

επισκέπτη θα δημιουργήσουμε κάποιες κατηγορίες.  

Για να δημιουργήσουμε μια κατηγορία στο HikaShop πηγαίνουμε από την περιοχή 

διαχείρισης του στο Products->Categories και πατάμε New. 
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 Στο πεδίο Name γράφουμε το όνομα της κατηγορίας το οποίο θα είναι 

Συμπληρώματα. 

 Στο Description μπορούμε αν θέλουμε να εισάγουμε μια περιγραφή. 

 Στο Images θα εισάγουμε μια φωτογραφία για την κατηγορία μας. 

Πατάμε Save&Close και αποθηκεύεται η κατηγορία μας. 

 

Σχήμα 41: Δημιουργία κατηγορίας στο HikaShop 

Με τον ίδιο τρόπο δημιουργήσαμε όλες τις κατηγορίες που θέλουμε να εμφανίζονται 

στην ιστοσελίδα μας. 

 

Σχήμα 42:  Όλες οι κατηγορίες που δημιουργήσαμε 

5.3.17. Δημιουργία Υποκατηγοριών στο HikaShop 

Θα χρειαστεί να χωρίσουμε τις κατηγορίες σε υποκατηγορίες στις οποίες θα 

συμπεριλαμβάνονται τα προϊόντα μας. Πηγαίνουμε στην επιλογή Products-

>Categories και πατάμε New. Στο πεδίο Name γράφουμε το όνομα της 
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υποκατηγορίας μας το οποίο θα είναι Υπερτροφές. Στο Additional information που 

υπάρχει δεξιά θα πάμε στην επιλογή parent category για να ορίσουμε σε ποια 

κατηγορία θα ανήκει. Επιλέγουμε λοιπόν την κατηγορία Συμπληρώματα. Στο Images 

εισάγουμε την εικόνα που θέλουμε να εμφανίζεται. Πατάμε Save&Close για να 

αποθηκεύσουμε τις ρυθμίσεις της υποκατηγορίας μας. 

 

Σχήμα 43: Δημιουργία Υποκατηγορίας 

Με τον ίδιο τρόπο δημιουργήσαμε όλες τις υποκατηγορίες. 

 

Σχήμα 44:  Όλες οι υποκατηγορίες 

5.3.18. Δημιουργία προϊόντων  

Για να δημιουργήσουμε ένα νέο προϊόν πηγαίνουμε από το μενού του HikaShop στο 

Products->Add a product. Στο Name γράφουμε το όνομα του προϊόντος. Στο 

Description εισάγουμε μια περιγραφή. Στη επιλογή Categories->Add ορίζουμε σε 

ποια κατηγορία ανήκει το συγκεκριμένο προϊόν. Στο Related products προσθέτουμε 

όλα τα προϊόντα που σχετίζονται με το συγκεκριμένο. Στο Prices βάζουμε την τιμή 

του προϊόντος. Στο Images βάζουμε τη σχετική φωτογραφία που θέλουμε να 

εμφανίζεται. Στο Brands που υπάρχει παρακάτω ορίζουμε σε ποιόν προμηθευτή 

ανήκει. Για να συνδέσουμε το προϊόν με το pdf αρχείο που περιέχει την περιγραφή 
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του γράφουμε στον Editor Περιγραφή προϊόντος και το ορίζουμε σαν υπερσύνδεσμο. 

Κάνουμε Upload το αρχείο που θέλουμε και τέλος πατάμε Save&Close. 

 

Σχήμα 45: Δημιουργία προϊόντος 

Με την είσοδο μας σε κάποιο προϊόν εμφανίζεται το link που μας οδηγεί στην 

περιγραφή του και επιπλέον σχετικά προϊόντα. 

 

 

Σχήμα 46: Εμφάνιση του προϊόντος στην ιστοσελίδα μας 

Πατώντας τον υπερσύνδεσμο μεταφερόμαστε στο pdf αρχείο με την περιγραφή του 

προϊόντος. 
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Σχήμα 47: Περιγραφή προϊόντος 

Με τον ίδιο τρόπο θα δημιουργήσουμε και τα υπόλοιπα προϊόντα και θα τα 

καταχωρήσουμε στις κατηγορίες τις οποίες ανήκουν. 

5.3.19. Αγορά προϊόντος 

Για την αγορά κάποιου προϊόντος θα πρέπει πρώτα ο χρήστης να έχει κάνει είσοδο 

με τα στοιχεία του μέσω της login form. Σε περίπτωση που δεν διαθέτει λογαριασμό 

θα πρέπει να δημιουργήσει. Αφού λοιπόν κάνουμε είσοδο στο σύστημα με τα 

στοιχεία μας, επιλέγουμε το προϊόν που θέλουμε και πατάμε Add to cart. Εμφανίζεται 

η παρακάτω σελίδα στην οποία πρέπει να επιλέξουμε τον τρόπο αποστολής και 

πληρωμής. Αναφέρεται επίσης η τιμή του προϊόντος  μαζί με το ΦΠΑ και τα έξοδα 

αποστολής. 

 

Σχήμα 48: Αγορά προϊόντος 
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Πατώντας Finish η αγορά μας ολοκληρώνεται και εμφανίζει μήνυμα πως θα πρέπει 

να πληρώσουμε το ποσό στον τραπεζικό λογαριασμό μιας και διαλέξαμε η πληρωμή 

να γίνει με αυτόν τον τρόπο. 

 

Σχήμα 49: Ολοκλήρωση αγοράς 

5.4. Εφαρμογή Google Drive στην ιστοσελίδα μας 

5.4.1. Δημιουργία Εγγράφου 

Για να δημιουργήσουμε ένα αρχείο στο Google Drive θα πρέπει να συνδεθούμε 
αρχικά στον λογαριασμό μας. Στη συνέχεια πηγαίνουμε στη διεύθυνση 
drive.google.com όπου μεταφερόμαστε στην κεντρική σελίδα του Google Drive. 
Πατώντας στην επιλογή ΔΗΜΙΟΥΡΓΙΑ μας εμφανίζει μια λίστα με τους τύπους των 
αρχείων που μπορούμε να δημιουργήσουμε. Αυτοί είναι Φάκελος, Έγγραφο, 
Παρουσίαση, Υπολογιστικό φύλλο, Φόρμα και παρουσίαση. Εμείς αρχικά θα 
φτιάξουμε ένα απλό έγγραφο το οποίο θα το ενσωματώσουμε μέσα σε ένα άρθρο 
της σελίδας μας. Πατώντας  την επιλογή έγγραφο μας εμφανίζει την σελίδα στην 
οποία θα γράψουμε το κείμενο μας. 

 

 
Σχήμα 50: Δημιουργία εγγράφου στο google docs 

Αφού γράψουμε το κείμενο μας και πατήσουμε Κοινή χρήση, μας εμφανίζει την 
παρακάτω σελίδα. 
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Σχήμα 51: Ρυθμίσεις πρόσβασης 

Βλέπουμε ότι μόνο εμείς έχουμε πρόσβαση στο συγκεκριμένο έγγραφο οπότε θα 
πατήσουμε Αλλαγή ώστε να το ρυθμίσουμε να έχουν πρόσβαση όλοι οι χρήστες που 
είναι συνδεδεμένοι στο διαδίκτυο. 

 
Σχήμα 52: Ρυθμίσεις κοινής χρήσης 

Για να εμφανιστεί το έγγραφο μέσα στην ιστοσελίδα μας θα πρέπει να αντιγράψουμε 
το url στον παρακάτω κώδικα και να το προσθέσουμε στο article που επιθυμούμε.  

{google_docs} document_url {/google_docs} 

 
Σχήμα 53: Αντιγραφή κώδικα 
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Εισάγουμε τον κώδικα στο άρθρο και στη συνέχεια πατάμε Save&Close για να το 
αποθηκεύσουμε. 

 
Σχήμα 54: Εισαγωγή κώδικα στο άρθρο 

 
Σχήμα 55: Εμφάνιση google doc εγγράφου 

5.4.2. Δημιουργία Ερωτηματολογίου 

Θα δημιουργήσουμε ένα ερωτηματολόγιο σχετικά με τα βιολογικά προϊόντα το οποίο 
θα μπορεί να το κάνει ο κάθε επισκέπτης της ιστοσελίδας μας. Πριν παρουσιάσουμε 
τον τρόπο δημιουργίας του θα αναφερθούμε στους διαθέσιμους τύπους ερωτήσεων 
που μας προσφέρει το Google Drive και μπορούμε να τους προσθέσουμε στο 
ερωτηματολόγιο μας. Αυτές είναι απλό κείμενο, κείμενο παραγράφου, ερώτηση 
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πολλαπλών επιλογών, ερώτηση με checkboxes, επιλέγοντας από τη λίστα, ερώτηση 
με κλίμακα τιμών, συγγενείς ερωτήσεις σε πίνακα. Η διαδικασία απαιτεί την επιλογή 
ΔΗΜΙΟΥΡΓΙΑ όπως και προηγουμένως και στη συνέχεια επιλογή ‘’Φόρμα’’που 
εμφανίζει την παρακάτω σελίδα όπου βάζουμε ένα τίτό στη φόρμα μας και 
επιλέγουμε κάποιο από τα προεπιλεγμένα θέματα. 

 

 
Σχήμα 56: Επιλογή φόντου 

Πατώντας Τέλος εμφανίζεται η παρακάτω σελίδα όπου θα ξεκινήσουμε να 
προσθέτουμε τις ερωτήσεις του ερωτηματολογίου. Στο πεδίο Τίτλος εισάγουμε την 
ερώτηση που θέλουμε να εμφανίζεται. Στο πεδίο Τύπος Ερώτησης επιλέγουμε έναν 
από τους 7 τύπους ερωτήσεων που αναφέραμε παραπάνω. Αφού ολοκληρώσουμε 
πατάμε Τέλος και με τον ίδιο τρόπο δημιουργούμε όλες τις ερωτήσεις.  

 

 
Σχήμα 57: Δημιουργία ερωτήσεων 
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Αφού ολοκληρώσουμε με τις ερωτήσεις πατάμε αποστολή φόρμας και εμφανίζεται η 
παρακάτω σελίδα. Αυτό που πρέπει να κάνουμε είναι να αντιγράψουμε το url που 
μας εμφανίζει στο άρθρο Joomla που θέλουμε να εμφανίζεται το άρθρο μας. 

 
Σχήμα 58: Αντιγραφή κώδικα 

Το Ερωτηματολόγιο εμφανίζεται στην ιστοσελίδα μας όπως φαίνεται παρακάτω. 

 

 
Σχήμα 59: Εμφάνιση ερωτηματολογίου στη σελίδα 

Κάθε φορά που ο επισκέπτης απαντάει στο ερωτηματολόγιο μας, έχουμε τη 
συνατότητα να δούμε τις απαντήσεις του αφού αυτόματα έχει δημιουργηθεί στη 
σελίδα του Google Drive ένα αρχείο με τις απαντήσεις. 
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Σχήμα 60: Τα google docs έγγραφα μου 

Ανοίγοντας το αρχείο με τις απαντήσεις όπως φαίνεται παρακάτω βλέπουμε την 
ημερομηνία και την ώρα που ο επισκέπτης συμπλήρωσε το ερωτηματολόγιο, καθώς 
και τις απαντήσεις του σε κάθε ερώτηση. 

 
Σχήμα 61: Αρχείο με τις απαντήσεις 

5.5. Δημιουργία Google Analytics 

Πρώτα από όλα, η υπηρεσία απαιτεί εγγραφή για την χρήση της και την αξιοποίηση 
των δυνατοτήτων της. Αν έχετε ήδη λογαριασμό email στο Google Mail, τότε μπορείτε 
να τον χρησιμοποιήσετε για να εισέλθετε στην πλατφόρμα διαχείρισης. Στην σελίδα 
http://www.google.com/analytics/, μπορείτε να δείτε την φόρμα εισόδου/εγγραφής 
και με την είσοδό σας, θα αποκτήσετε πρόσβαση στην κεντρική σελίδα διαχείρισης. 
Ένα από τα πρώτα βήματα αποτελεί η προσθήκη μιας ιστοσελίδας προς 
παρακολούθηση. Θα σας ζητηθούν τα στοιχεία της ιστοσελίδας, δηλαδή το όνομα και 
η διεύθυνση, τα προσωπικά σας στοιχεία, η περιοχή και η χώρα σας. Τέλος, 
απαιτείται να συμφωνήσετε με τους όρους χρήσης της υπηρεσίας. 

Αμέσως μόλις προστεθεί η νέα ιστοσελίδα, το Analytics σας παρέχει τον κώδικα, τον 
οποίο καλείστε να προσθέσετε στην ιστοσελίδα σας. Η εγκατάσταση του κώδικα 
απαιτεί βασικές γνώσεις HTML. Μόλις προστεθεί η ιστοσελίδα, το Google Analytics 

μας παρέχει τον κώδικα τον οποίο τον προσθέτουμε στην ιστοσελίδα μας, συνήθως στο 

<head>. Με τον συγκεκριμένο κώδικα, κάθε φορά που κάποιος επισκέπτεται τη σελίδα 

μας συλλέγονται όλες οι πληροφορίες που μας παρέχει το Google Analytics. 

http://www.google.com/analytics/
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Σχήμα 62: Κώδικας Google Analytics 

 
Σχήμα 63: Περιοχή Διαχείρισης Google Analytics 

 

Σχήμα 64: Στατιστικά Στοιχεία Google Analytics 
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Έχουμε τη δυνατότητα τα δούμε την επισκεψιμότητα ανά ώρα,ημέρα,εβδομάδα και 
μήνα. Στα δημογραφικά στοιχεία εμφανίζονται πληροφορίες για το χρήστη όπως η 
γλώσσα, από ποιά χώρα είναι καθώς και την πόλη. Στο Σύστημα βλέπουμε με ποιό 
πρόγραμμα περιήγησης επισκέπτηκε τη σελίδα μας, ποιό είναι το Λειτουργικό του 
σύστηκα και οι παροχές υπηρεσιών. Στην επιλογή Για το Κινητό αναφέρονται οι 
πληροφορίες όταν ο επισκέπτης έχει συνδεθεί στη σελίδα μας απο το κινητό του 
τηλέφωνο. 

5.6. Δημιουργία Google Maps 

Η προσθήκη χάρτη είναι πολύ σημαντική στην ιστοσελίδα μας για την ευκολότερη 
πλοήγηση του χρήστη ώστε να βρούν τη διεύθυνση μας, καθώς και όλων των 
προμηθευτών μας. 

5.6.1. Δημιουργία χάρτη ενός σημείου  

Σκοπός μας είναι να εμφανίζουμε τη διεύθυνση μας στο χάρτη.Κατεβάζουμε και 
κάνουμε εγκατάσταση το plugin Embeb google maps .Ανοίγοντας το plugin ύπάρχουν 
ρυθμίσεις σχετικά με το πως θέλουμε να εμφανίζεται ο χάρτης στη σελίδα μας. Στη 
συνέχεια πρέπει να αντιγράψουμε τον κώδικα  

{google_map}address(/google_map} 

αντικαθιστώντας το address με τις συντεταγμενες  της περιοχής που θέλουμε να 
δηλώσουμε στις σελίδες της σελίδας που θέλουμε να εμφανίζεται ο χάρτης. 

 
Σχήμα 65: Ρυθμίσεις εν θέματος Google maps 

5.6.2. Δημιουργία χάρτη πολλαπλών σημείων 

 

Για να προσθέσουμε τις διευθύνσεις των προμηθευτών μας θα μεταβούμε στη 
σελίδα https://maps.google.gr/ για να δημιουργήσουμε ένα δικό μας χάρτη. 
Πηγαίνουμε λοιπόν στην επιλογή Τα μέρη μου και στη συνέχει Δημιουργία χάρτη. 
Στον Τίτλο θα γράψουμε Προμηθευτές και προαιρετικά κάποια περιγραφή.Στη 
συνέχεια ορίζουμε με σημεία τις διευθύνσεις των προμηθευτών και πατάμε Τέλος. 

https://maps.google.gr/
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Σχήμα 66: Google maps 

Αφού δημιουργήσαμε όλα τα σημεία πρέπει να αντιγράψουμε τον HTML κώδικα στα σημεία 
της σελίδας μας που θέλουμε να εμφανίζεται ο χάρτης. 

 
Σχήμα 67: Δημιουργία πολλαπλών σημείων 

Πηγαίνοντας στη σελίδα μας βλέπουμε το χάρτη με τη διεύθυνση μας,καθώς και λενα 

υπερσύνδεσμο που μας μεταφέρει στις διευθύνσεις των προμηθευτών. 

 
Σχήμα 68: Εμφάνιση του χάρτη στη σελίδα μας 
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Σχήμα 69: Διευθύνσεις των προμηθευτών 
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6. Συμπεράσματα 
 

Το διαδίκτυο παίζει πολύ σημαντικό ρόλο στην καθημερινότητα των ανθρώπων. Με 

την ανάπτυξη του διαδικτύου έχουμε και ανάπτυξη του ηλεκτρονικού εμπορίου. Τα 

οφέλη του ηλεκτρονικού εμπορίου δεν αφορούν μόνο τους πελάτες αλλά και την ίδια 

την ηλεκτρονική εταιρία. Η ανάπτυξη του ηλεκτρονικού εμπορίου έκανε τους 

ιδιοκτήτες εταιριών να ασχοληθούν με την ηλεκτρονική διαφήμιση.  

Η χρήση των Διεπιχειρησιακών Πληροφοριακών Συστημάτων είναι αυτή που 

πραγματοποιεί τις ηλεκτρονικές αγορές. Τα Διεπιχειρησιακά Πληροφοριακά 

Συστήματα λειτουργούν μεταξύ δυο ή περισσότερων οργανισμών , συνδέοντας τις 

επιχειρήσεις με τους πελάτες ή τους προμηθευτές. Οι τρείς κύριοι τύποι είναι : 

Ηλεκτρονικές Δυάδες, Πολυμερές και Ηλεκτρονικό μονοπώλιο. 

To cloud computing είναι ένα μοντέλο που μας δίνει τη δυνατότητα να 

χρησιμοποιούμε και να έχουμε πρόσβαση σε web εφαρμογές χωρίς να υπάρχουν 

στον υπολογιστή μας ή σε κάποια άλλη συσκευή που είναι συνδεδεμένη στο internet. 

Το Google Drive που χρησιμοποιήσαμε μας έδωσε τη δυνατότητα να διαχειριστούμε 

εύκολα και απλά τα αρχεία που συμπεριλαμβάνονται στο ηλεκτρονικό μας 

κατάστημα. Το Google Analytics μέσω των στατιστικών στοιχείων που μας παρέχει 

μας βοηθάει ώστε να βελτιστοποιήσουμε τη σελίδα μας. Τέλος, το google maps 

βοηθάει τον επισκέπτη για τη συλλογή απαραίτητων πληροφοριών που αφορά τις 

διευθύνσεις του καταστήματος και των προμηθευτών μας. 

Για την εκπόνηση αυτής της εργασίας δημιουργήσαμε ένα ηλεκτρονικό κατάστημα 

βιολογικών προϊόντων με ονομασία «Bioshop» . Κάνοντας χρήση μέσω του πλέον 

διαδεδομένου συστήματος διαχείρισης περιεχομένου Joomla την εφαρμογή 

HikaShop η ιστοσελίδα μας κατάφερε να γίνει πιο εμπορική και ανταγωνιστική στις 

ηλεκτρονικές αγορές. Βασικός στόχος ήταν να δημιουργηθεί ένα ηλεκτρονικό 

κατάστημα το οποίο θα είναι φιλικό προς το χρήστη, θα έχει εύκολη προσβασιμότητα 

και απλή διαδικασία αγοράς προϊόντων. Από την άλλη πλευρά η ιστοσελίδα μας θα 

πρέπει να είναι προσιτή προς τον ιδιοκτήτη του καταστήματος ο οποίος θα μπορεί να 

παρακολουθεί τη πορεία του και την εξέλιξη των πωλήσεων.  
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7. Παράρτημα Ι: Η εγκατάσταση του XAMPP 
Για να ξεκινήσουμε τη δημιουργία της ιστοσελίδας που πρόκειται να δημιουργήσουμε θα 

πρέπει να κατεβάσουμε αρχικά ένα τοπικό server , όπως είναι ο XAMPP 

 

 

Σχήμα 70 Εγκατάσταση Xampp βήμα 1 

 

 

Σχήμα 71 Εγκατάσταση Xampp βήμα2 
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Σχήμα 72 Εγκατάσταση Xampp βήμα 3 

 

Σχήμα 73 Εγκατάσταση Xampp βήμα 4 

 

Σχήμα 74 Εγκατάσταση Xampp βήμα 5 
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Αφού έχει εγκατασταθεί ο xampp, πάμε στην επιφάνεια εργασίας και κάνουμε διπλό κλικ 

στο εικονίδιο “XAMPP Control Panel ”, ενεργοποιούμε τις επιλογές Apache και MySQL και 

πατάμε start. Αυτό θα μας εμφανίσει την παρακάτω εικόνα.  

 

 

Σχήμα 75 Εγκατάσταση Xampp 

Δημιουργία της βάσης δεδομένων  

Τώρα αυτό που πρέπει να κάνουμε είναι να δημιουργήσουμε τη βάση δεδομένων 

μας. Θα πάμε στη διεύθυνση http://localhost/phpmydamin 

 

Σχήμα 76 Δημιουργία βάσης δεδομένων 
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8. Παράρτημα ΙΙ: Εγκατάσταση του Joomla 
Αφού ολοκληρώθηκε η εγκατάσταση του XAMPP και η δημιουργία της βάσης 

δεδομένων σειρά έχει η εγκατάσταση του Joomla. θα κατεβάσουμε από την επίσημη 

ιστοσελίδα www.joomla.org το συμπιεσμένο αρχείο εγκατάστασης του joomla το 

οποίο θα το αποσυμπιέσουμε και θα το αντιγράψουμε στον υποφάκελο htdocs του 

φακέλου xampp. Ο υποφάκελος που θα δημιουργήσουμε χάριν δικής μας 

διευκόλυνσης θα έχει το όνομα της βάσης που δημιουργήσαμε.  

 

Σχήμα 77 Εγκατάσταση Joomla 

Μόλις τελειώσουμε με την δημιουργία του φακέλου, ανοίγουμε τον περιηγητή μας 

και πληκτρολογούμε http://localhost/Bio. Η εγκατάσταση του Joomla 3.2 είναι μια 

απλή διαδικασία και ολοκληρώνεται με τα παρακάτω βήματα. 

Βήμα 1: Ρυθμίσεις 

 Από την αναδιπλούμενη λίστα Select Language, επιλέγουμε σε ποια γλώσσα 

θα γίνει η εγκατάσταση. Εμείς επιλέγουμε την Αγγλική. 

 Στο πλαίσιο Site name εισάγουμε το όνομα της ιστοσελίδας που θα 

δημιουργήσουμε. Το όνομα της ιστοσελίδας μας θα είναι bioshop. 

 Στο πλαίσιο Description μπορούμε να εισάγουμε προαιρετικά μια περιγραφή 

σχετικά με την ιστοσελίδα που θα δημιουργήσουμε. 

 Στο πλαίσιο κειμένου Admin Email εισάγουμε το e-mail του διαχειριστή της 

σελίδας το οποίο θα χρησιμεύσει αργότερα στην επικοινωνία του με τους 

χρήστες. Έτσι εισάγουμε το dimitra.mela@gmail.com 

 Στο πλαίσιο Admin Username εισάγουμε το username για να μπορέσουμε να 

συνδεθούμε στην Περιοχή Διαχείρισης. Το username θα είναι dimitra. 

mailto:dimitra.mela@gmail.com
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 Στο πλαίσιο κειμένου Admin Password εισάγουμε τον κωδικό που θα 

χρησιμοποιήσουμε για να κάνουμε είσοδο στην Περιοχή Διαχείρισης. 

 Στο πλαίσιο κειμένου Confirm Password επαναλαμβάνουμε τον ίδιο κωδικό. 

 

 

Σχήμα 78 Εγκατάσταση Joomla βήμα 1 

Όταν ολοκληρώσουμε αυτή τη διαδικασία πατάμε το κουμπί Next. 

 

Βήμα 2: Βάση Δεδομένων 

Βρισκόμαστε στο πιο σημαντικό βήμα της εγκατάστασης το οποίο αφορά τη βάση 

δεδομένων. Εδώ θα πρέπει να κάνουμε εισαγωγή των στοιχείων της βάσης 

δεδομένων με την οποία θα επικοινωνεί το Joomla. 

 

Σχήμα 79 Εγκατάσταση Joomla βήμα 2 
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 Από τη λίστα Database Type επιλέγουμε MySQLi 

 Στο πλαίσιο κειμένου Host Name εισάγουμε το όνομα localhost. 

 Στο πλαίσιο κειμένου Username εισάγουμε το όνομα του χρήστη που έχουμε 
ορίσει στη βάση δεδομένων. Στην περίπτωση τοπικής εγκατάστασης 
εισάγουμε root. 

 Στο πλαίσιο κειμένου Password εισαγάγουμε τον κωδικό του χρήστη που 
έχουμε ορίσει στη βάση δεδομένων. Στην περίπτωση τοπικής εγκατάστασης το 
αφήνουμε κενό. 

 Στο πλαίσιο κειμένου Database Name εισαγάγουμε το όνομα της βάσης μας. 

 Στο πλαίσιο κειμένου Table Prefix  εμφανίζεται ένα τυχαίο αλφαριθμητικό που 
μπαίνει μπροστά από το όνομα των πινάκων που θα δημιουργηθούν στη βάση 
δεδομένων. 

 

Όταν ολοκληρώσουμε αυτή τη διαδικασία πατάμε το κουμπί Next. 

Βήμα 3: Επισκόπηση 

 

Σχήμα 80 Εγκατάσταση Joomla βήμα 3 

 

Στο βήμα αυτό το Joomla κάνει κάποιους ελέγχους σχετικά με τη συμβατότητα του 

συστήματός μας .Επιλέγοντας το κουμπί Installation ξεκινάει η διαδικασία της 

δημιουργίας της βάσης δεδομένων και της εγκατάστασης. Όταν ολοκληρωθεί 

εμφανίζεται η παρακάτω οθόνη. 
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Σχήμα 81 Εγκατάσταση Joomla βήμα 4 

Στη συνέχει πρέπει να διαγράψουμε το φάκελο installation για λόγους ασφαλείας. 

Αφού διαγράψουμε το φάκελο installation έχουμε δύο επιλογές: 

  Να μεταφερθούμε στο Front End (Εμφάνιση Ιστοσελίδας) κάνοντας κλικ στο 
κουμπί Site. 

  Να μεταφερθούμε στο Back End (Περιοχή Διαχείρισης) κάνοντας κλικ στο 
κουμπί Administrator. 

 

Διαχείριση Περιεχομένου Joomla  

Για να εισέλθουμε στη σελίδα διαχείρισης αρκεί μόνο να πληκτρολογήσουμε στη 

γραμμή διεύθυνσης localhost/bioshop/administrator και να εισάγουμε τα στοιχεία 

μας. 

 

 

Με τον τρόπο αυτό ανοίγουμε την κεντρική σελίδα διαχείρισης του ιστότοπου μας. 
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Σχήμα 82 Περιοχή Διαχείρισης Joomla 

Εγκατάσταση ελληνικής γλώσσας στο Joomla 

Ανοίγουμε την καρτέλα Extensions και κάνουμε κλικ στην επιλογή Language 

Manager.Στη συνέχεια επιλέγουμε Install Language και εμφανίζεται η παρακάτω 

οθόνη  : 

 

 

Σχήμα 83 Εγκατάσταση Ελληνικής γλώσσας 
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Κάνουμε αναζήτηση της ελληνικής γλώσσας και στη συνέχεια πατάμε Install  

 

Σχήμα 84 Install ελληνικής γλώσσας 

 

Για να ενεργοποιήσουμε την ελληνική γλώσσα πηγαίνουμε στην επιλογή Extensions 

-> Language Manager και επιλέγουμε την ελληνική γλώσσα σαν Default όπως 

φαίνεται και στην παρακάτω εικόνα.

 

Σχήμα 85 Ενεργοποίηση ελληνικής γλώσσας 
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9. Παράρτημα ΙIΙ: Εγκατάσταση HikaShop 
 

Πηγαίνουμε στη σελίδα www.hikashop.com/download .html και κατεβάζουμε το 

συμπιεσμένο αρχείο. 

 

 

Σχήμα 86 Εγκατάσταση HikaShop 

 

To HikaShop είναι ένα Extension του Joomla οπότε η εγκατάσταση του γίνεται όπως 

όλων των Extensions.Πηγαίνουμε στην καρτέλα Extensions->Extension Manager και 

κάνουμε αναζήτηση του αρχείου που κατεβάσαμε.  

Αφού το επιλέξουμε πατάμε Upload&Install. 

 

 

Σχήμα 87 Αναζήτηση αρχείου Hikashop 

http://www.hikashop.com/download%20.html


Πτυχιακή : Ανάλυση συστημάτων διεπιχειρησιακής συνεργασίας στο διαδίκτυο 
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Βλέπουμε την επιτυχή εγκατάσταση του HikaShop 

 

 

Σχήμα 88 Επιτυχής εγκατάσταση 

 

Στη συνέχεια θα συμπληρώσουμε τα στοιχεία Location και Main Parameters. 

 Στο Country επιλέγουμε Greece. 

 Στο State επιλέγουμε Ηράκλειο. 

 Στο Address βάζουμε μια διεύθυνση. 

 Στο Tax name γράφουμε ΦΠΑ. 

 Στο Rate βάζουμε 21% που θα είναι ο φόρος μας. 

 

Σχήμα 89 Ρυθμίσεις hikashop 
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 Σελίδα 79 
 

Πηγαίνοντας στην καρτέλα Components βλέπουμε ότι έχει προστεθεί το 

HikaShop.Πατώντας πάνω του εμφανίζεται η κεντρική σελίδα του HikaShop. 

 

Σχήμα 90 Περιοχή Διαχείρισης Hikashop 
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10. Πηγές 
 

http://www.w3schools.gr  

http://2epal-n-smyrn.att.sch.gr/files/E-Commerce.pdf 

http://www.joomla.gr/  

http://www.joomla.org/  

http://www.php.net/  

http://networking-basics.wikispaces.com  

http://www.apachefriends.org/  

http://el.wikipedia.org/  

https://www.hikashop.com/ 

https://www.hikashop.com/extensions.html 

http://en.wikipedia.org/wiki/Interorganizational_system 

https://domino.fov.uni-

mb.si/proceedings.nsf/0/02d5f171ae4576e8c1257014004a2af8/$FILE/29Ravarini.pdf 

http://en.wikipedia.org/wiki/EMarketPlace 

http://www.agrocert.gr/pages/content.asp?cntID=75&catID=48 

http://www.slideshare.net/rodotheos/cms-421346 

http://www.webopedia.com/TERM/D/database_management_system_DBMS.html  

 

 

 


